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Warranty and liability

Warranty and liability

Note

Security
information

The Application Examples are not binding and do not claim to be complete regarding the
circuits shown, equipping and any eventuality. The Application Examples do not represent
customer-specific solutions. They are only intended to provide support for typical
applications. You are responsible for ensuring that the described products are used
correctly. These application examples do not relieve you of the responsibility to use safe
practices in application, installation, operation and maintenance. When using these
Application Examples, you recognize that we cannot be made liable for any
damage/claims beyond the liability clause described. We reserve the right to make
changes to these Application Examples at any time without prior notice. If there are any
deviations between the recommendations provided in these application examples and
other Siemens publications — e.g. Catalogs — the contents of the other documents have
priority.

We do not accept any liability for the information contained in this document.

Any claims against us — based on whatever legal reason — resulting from the use of
the examples, information, programs, engineering and performance data etc.,
described in this Application Example shall be excluded. Such an exclusion shall
not apply in the case of mandatory liability, e.g. under the German Product Liability
Act ("Produkthaftungsgesetz"), in case of intent, gross negligence, or injury of life,
body or health, guarantee for the quality of a product, fraudulent concealment of a
deficiency or breach of a condition which goes to the root of the contract
("wesentliche Vertragspflichten"). The damages for a breach of a substantial
contractual obligation are, however, limited to the foreseeable damage, typical for
the type of contract, except in the event of intent or gross negligence or injury to
life, body or health. The above provisions do not imply a change of the burden of
proof to your detriment.

Any form of duplication or distribution of these Application Examples or excerpts
hereof is prohibited without the expressed consent of the Siemens AG.

Siemens provides products and solutions with industrial security functions that support the
secure operation of plants, systems, machines and networks.

In order to protect plants, systems, machines and networks against cyber threats, it is
necessary to implement — and continuously maintain — a holistic, state-of-the-art industrial
security concept. Siemens’ products and solutions only form one element of such a
concept.

Customers are responsible for preventing unauthorized access to their plants, systems,
machines and networks. Systems, machines and components should only be connected
to the enterprise network or the internet if and to the extent necessary and with
appropriate security measures (e.g. use of firewalls and network segmentation) in place.

Additionally, Siemens’ guidance on appropriate security measures must be taken into
account. For more information about industrial security, please visit
http://www.siemens.com/industrialsecurity.

Siemens’ products and solutions undergo continuous development to make them more
secure. Siemens strongly recommends applying product updates as soon as available
and always using the latest product versions. Using versions that are obsolete or are no
longer supported can increase the risk of cyber threats.

To stay informed about product updates, subscribe to the Siemens Industrial Security
RSS feed at http://www.siemens.com/industrialsecurity.
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Foreword

Foreword

Aim of this document

Typical PCS 7 systems have at least one ES (Engineering Station) on the PC side,
one or more possibly redundant servers and several OS clients (Operator Stations).

In addition to the maximum availability of process control and data acquisition, there is
also the possibility of integrating program adjustments or expansions in the foreground,
quickly and without affecting the current process.

In contrast, small systems or stand-alone units often require very little maintenance
after commissioning. To achieve high efficiency, there exists the requirement to get
along with as few PC stations as possible. It therefore makes sense to utilize the

rarely used ES as an OS in process mode.

This document is intended to help you in choosing a suitable PC set-up for small
systems. It compares various minimal configurations (up to a maximum of three PCs)
in terms of their functionality. Since the corresponding PCS 7 configuration is not the
main focus of the system documentation, here you can also find the necessary
activities for installation in the form of detailed step instructions.

Core contents
The main focus is on the following:
e Configuration comparison regarding functionality
e Activities for configuration, activation, and maintenance of different configurations

PCS 7 Minimal Configurations
Entry ID: 24023824, V7.1, 02/2018 3
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1 Overview of Minimal Configurations

1.1 ES/OS Single Station

1

1.1

Overview of Minimal Configurations

There are various possible options when utilizing the engineering station in process
mode as an operator station or multiple operator stations with as few PCs as possible.
The following versions were selected according to their feasibility and usefulness in
the context of PCS 7.

The configurations shown here also include descriptions of solutions with configurations
that do not differ significantly from each other.

In general, particular functionality criteria must be considered when using the engineering
PC as an OS, because the OS project must be closed when performing certain activities.
This will also be discussed in more detail below.

ES/OS Single Station

The smallest of all configurations only needs one PC station.

ES/OS

Process mode/functionality

Note

Since version 6.1 of PCS 7, it has also been possible to compile the OS project
when runtime is activated (change compilation). This means that the operator and
archiving functions are present permanently.

You can find a description of this configuration and a how-to guide in chapter 3
"ES/OS Single Station".

Alternatives/variations

Note

The complete SIMATIC PCS 7 BOX package is also a good alternative. It combines
the AS, the OS, and the ES in one compact PC system. As an option, a PROFIBUS
or PROFINET interface is integrated in the same way to link to distributed process
peripherals.

The ES/OS Single Station can also be extended with the functionality of the
PCS 7 OS Web Server. You can find a guide to doing this in chapter 7
"Expansion with the PCS 7 OS Web Option".

PCS 7 Minimal Configurations
Entry ID: 24023824, V7.1, 02/2018 6
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1 Overview of Minimal Configurations

1.2 ES/OS Client and OS Server

1.2 ES/OS Client and OS Server

With an additional PC station as an OS server, the ES can be used as an OS client.
This accesses the data of the OS server in process mode and visualizes it.

Terminal bus

ES/OS Client OS Server

I |

Process mode/functionality

In PCS 7, the OS server can be used for operator functions when no more than
four OS clients are connected. In this example, if the server malfunctions, the
complete OS functionality fails. Besides this, the OS client must be terminated to
make OS project changes at a later stage. However, the OS server keeps on
working permanently at compiling/loading of changes.

Note You can find a description of this configuration and a how-to guide in chapter 4
"ES/OS Client and OS Server".

Alternatives/variations

One of the advantages of this configuration is the option of connecting additional
clients to the OS server on a relatively simple and inexpensive basis.

PCS 7 Minimal Configurations
Entry ID: 24023824, V7.1, 02/2018 7
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1 Overview of Minimal Configurations

1.3 ES, OS Master and OS Standby

1.3

ES, OS Master and OS Standby

You need three PC stations for PCS 7-compliant implementation of OS
redundancy.

In this case, the ES only carries out engineering tasks and, while doing this, is only
used for testing OS functions.

Terminal bus

ES OS Master OS Standby

Redundancy

A
\

COM-Cable

Process mode/functionality

Note

Since the ES is not involved in process mode, the operator functions of the two OS
Single Stations are permanently available. The OS remains active even during
complete loading of project changes. Redundancy ensures mutual synchronization
both when online and after the failure of one of the two partners.

The COM connection (RS 232 connecting cable) is for optimization of internal
server-to-server communication.

Since PCS 7 V7.0, it has been possible, as an alternative to the COM connection,
to use a separate Ethernet connection (a free on-board or additional network
adapter) for the redundancy connection.

You can find a description of this configuration and a how-to guide 5 "ES, OS
Master and OS Standby".

Alternatives/variations

In the case of the low-maintenance systems that this document focuses on, you
can often do without a permanently available if it is possible to rent a temporary ES
for configuration, commissioning, and project changes.

In this example, it is only conceivable to extend the system using additional OS
clients if a server operating system is installed on the OSes.

PCS 7 Minimal Configurations
Entry ID: 24023824, V7.1, 02/2018 8
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1 Overview of Minimal Configurations

1.4 ES/OS Master and OS Standby

1.4

ES/OS Master and OS Standby

In this configuration with two redundant OS Single Stations, one of the stations is
also used as a simultaneous ES, which obviates the need for a separate third
station.

Terminal bus

ES/OS Master OS Standby

Redundancy

COM-Cable

Process mode/functionality

Note

In this example, both PC stations work in process mode as redundant OS single
stations that balance each other both in operation and after the failure of one of the
two partners. This is also relevant for later OS project changes, which require the
Master OS to be exited. In this case, the Standby OS takes over the master role. It
keeps on working permanently while compiling/loading changes and updates the
redundancy partner after it returns.

The COM connection (RS 232 connecting cable) is used to optimize internal
communication between the two OS Single Stations.

Since PCS 7 V7.0, it has been possible, as an alternative to the COM connection,
to use a separate Ethernet connection (a free on-board or additional network
adapter) for the redundancy connection. For complete loading, you must deactivate
OS Runtime and the OS projects on both stations and close them. For this period,
no OS functionality is available.

This configuration does not offer all of the PCS 7 functionality, since redundancy
is set up using WinCC resources.

In chapter 6 "ES/OS Master and OS Standby*, you can find corresponding
limitations in process operation and differences in system behavior together with
a description of configuration and a how-to guide.

PCS 7 Minimal Configurations
Entry ID: 24023824, V7.1, 02/2018 9
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1 Overview of Minimal Configurations

1.4 ES/OS Master and OS Standby

Alternatives/variations

For PCS 7-compliant implementation of OS redundancy, we recommend using
three PC stations. With the changes to the license concept from PCS 7 V8.0
onward, you will need the same number of license packages. The implementation
of redundancy with two PC stations is associated with some limitations (see
chapter 6.1 "Configuration description") and, compared to PCS 7-compliant
implementation with a separate ES and two redundant OS Single Stations (see
chapter 1.3 "ES, OS Master and OS Standby*), only saves you one computer
(hardware and Windows license).

Note The ES/OS Single Station can also be extended with the functionality of the
PCS 7 OS Web Server. You can find a guide to doing this in chapter 7
"Expansion with the PCS 7 OS Web Option".

PCS 7 Minimal Configurations
Entry ID: 24023824, V7.1, 02/2018
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2 General/optional system settings

2.1 Bus connection of the PC stations

2

2.1

Plant bus

General/optional system settings

The system settings that are relevant to configuration are presented below.
Bus connection of the PC stations

In the ES and in each server, a network card is used in "Configured mode" for the
plant bus. On this network card, only the ISO protocol is enabled for Windows. If a
CP1623 is present, it is used for accessing the plant bus. Parameterization is
carried out in SIMATIC NetPro and in the HW Config.

Terminal bus

2.2

Except for configuration with only one ES/OS Single Station, all of the other PC
stations are additionally linked to the terminal bus. When doing this, the necessary
second network card of the ES and the server is set here to "PG mode”. This card
is not configured in SIMATIC NetPro and in the HW Config. PCS7 finds this
network access via the computer name or the specified path for the target machine
that must be entered in the object properties of the PC station. For this network
card, only the TCP/IP protocol (not ISO) is activated in Windows.

Client PC stations are generally fitted with only one network card that is used to
connect to the terminal bus. For this network card, only the TCP/IP protocol (not
ISO) is activated in Windows.

Autostarting WinCC

This document contains the step-by-step instructions for opening the OS project on
the OS servers and clients for runtime activation in the WinCC Explorer.

This should be usually avoided in the system, since there are generally no
configuration licenses (RC licenses) on the OSes. If WinCC Explorer is open for
longer than two hours while doing this, WinCC switches to Demo mode and you
must close it completely (including runtime) and reopen it for further configuration
steps.

To activate runtime automatically when the computer starts without having to open
WinCC Explorer, you can configure an automatic start for the project.

In conjunction with SIMATIC NET 2005 Edition (WinCC V6.0 SP3 and above), you
should configure the "AutoStartRT" WinCC tool on the "Set configuration console
PC station" to configure the WinCC automatic start. You can find more information
in the following FAQs:

https://support.industry.siemens.com/cs/ww/en/view/23061262

PCS 7 Minimal Configurations
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3.1 Configuration description

3 ES/OS Single Station

3.1 Configuration description

The Single Station is the smallest possible configuration. The same PC is used for
both ES and OS functionality.

Hardware configuration

ES/OS

Plant bus

PCS 7 configuration
_ SIMATIC Manager - K1_MP = | Ellll

File Edit Insert PLC View Options Window Help
AR T EE T [T o Fiter > EEAE A==
- D:\Mininimal\Projects\K1\1_MP_MP_\1_MP_MP - |E||i|
=B E1_MP_Fij @ K5 _MP_Lib

-] Shared Declarations
+-§® K5_MP_Lib

E£® K1_MP (Plant View) -- D:\Mininimal\Projects\K1\1_MP_MP_\1 | =lox]
=-fzal K1_MP [Eq RMT1 [EIRMT2

=8P KI_MP_Prj

{7 Shared Declarations

i -- Flant
-6 K5_MP_Lik

PressF1 to get Help. PC internal.local. 1 v
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3.2 Required hardware and software licensing

3.2 Required hardware and software licensing

Hardware

The following hardware is recommended for this configuration and can be ordered
via the Siemens mall. Your selected operating system and the appropriate scope of
the SIMATIC PCS 7 system software are preinstalled on the PC station.

Station Product designation Operating Plant bus transition
system
1 xES/OS | SIMATIC PCS 7 ES/OS IPC847D BCE | Windows 7 RJ45 network card
SIMATIC PCS 7 ES/OS IPC847D IE Windows 7 CP1623

Software licensing

The following section lists the software/license package that are necessary for this
configuration selection.

In the selected configuration as a Single Station, the number of POs is limited to a
maximum of 2000.

Component Software/licence packages

ES/OS e SIMATIC PCS 7 ES Single Station (incl. 250 AS/OS Runtime POs)
e SIMATIC PCS 7 AS runtime license
e SIMATIC PCS 7 OS runtime license

PCS 7 Minimal Configurations
Entry ID: 24023824, V7.1, 02/2018 13
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3 ES/OS Single Station

3.3 Step-by-step configuration

3.3 Step-by-step configuration

Note The following instructions have been drawn up based on Windows 7 and
PCS 7 V9.0. A CP1623 is used as an example of the plant bus transition. Time
synchronization is activated.

3.3.1 ES configuration

Creating the multiproject

As the basis for the instructions below, the station must be physically networked as
shown in the illustration in chapter 3.1. Apart from this, you must create a
multiproject on the ES in which the hardware and software of the AS are already
configured.

AS settings
This example describes a way in which the OS server specifies the master time.

Note More time synchronization options are described in detail in the following
manuals:

e "SIMATIC PCS 7 Operator Station (V9.0)"
https://support.industry.siemens.com/cs/ww/en/view/109746516

e "SIMATIC Process Control System PCS 7 Time Synchronization (V9.0)"
https://support.industry.siemens.com/cs/ww/en/view/109746544

PCS 7 Minimal Configurations
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3 ES/OS Single Station

3.3 Step-by-step configuration

In the "Clock" section, set "As slave" for
the AS under “Synchronization Type”.
Click on the "OK" button to confirm your
selection.

Step Activity Screenshot
1. Open the HW Config for the AS. L 5w Config - [AS1 (Configuration) — K2_MP_Prj] T
Highliaht the CPU d ch "Obiect Bl Stston Edit Insert PLC View Options Window Help =]
| | e anda choose ec = o
ghtight the ¢ ) D@28 % &) 5e Do
properties..." in the shortcut menu. <
Copy culC
Paste CErl+
IF1 L | insertMuliGontroller Device
IF2
X5 PAHIO-XE Replace Object...
X5PIR Poi 1 Add Master: Systen
XeP2R ||| P2 Discannect Master System
X8 PIHOXE Mester System Lsochronous Mode
X8FIR Par 1 Inserk PROFINET 16 System
XEFZR For 2 Disconnect PROFINET 10 Syster
5 HiF CP 443-1 PROFINET 10 Domain Management. .
X1 PO PROFINET 10 Topalogy.
SHAT ik PROFINET IO Multi-Cantrollzr Devices...
f £2 e PROFINET 10 Isachronous mode
E Specify Module, .
Delete Del
GoTo 3
Filter Assigned Modules
Monitor/ ity
Alt+Return I'J
a Chrl4-Ale+G
Chanoe Acess. 3 =
ﬂ!l [0) URZALL Assign Asset ID...
Slat Module Product Support Information Ctrl+F2
7 i PS 407 108 FAQs ctrl+F7
Find Manual cirl+Fs
d CPU 410-5H | e o »
T Start Device Tool
Displays properties of the selected objectﬁ am‘ng‘ i
2. Switch to the "Diagnostics/Clock" tab. Prapertics ~CEUATIESIEERES) x|

General | Statup | Cycle/Clock Memory | Retentive Memory | Memory | Intemupts |

Time-of Day Intemupts | Cyclic Intemupts  Diagnestics/Clock | Protection | H Parameters
~System Di
™| Extended functions
it cause of STOF]
I~ Acknowledgment friggered reporting of SFB33-35
Number of messages in the diagnostics buffer W
~Clock
Synchrorization Synchronization Type Time Interval
Inthe PLC [ s slave I [ =
ri the WP [None =] [Nene =
O the W [one =] [rione =
Comrection factor: lD— ms
Cancel Help
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3 ES/OS Single Station

3.3 Step-by-step configuration

Step

Activity

Screenshot

3.

Open the shortcut menu of the CP and
select "Object properties...".

D" &g ae dal S8 e

[ HW Config - [AS1 (Configuration) -- K2_MP_Prj] - o) x|
E“]Staﬁoﬂ Edit Insert PLC View Options Window Help - ﬂﬁl

i) URZALD
1 PS 407 10A B
3 CPU 4105H
X §or
IF1

Copy cirl+C
Paste |+
Insert Multi-Cantraller Device

El Replace Object...
| AddMaster System
Disconnect Master System
[Master System Tsochronous Mode
Insert PROFINET I8 Systen
Disconmect PROFINET 10 System
PROFINMET IO Dornain Mansgement.
PROFINET 12 Tapalagy..
PREFIMET I Mulki-Contraller Devices, ..
PREFIHET I Isachroneus mode:

0
0] URZaLU
:I:I o GoTo »

Slot Module  Filter Assigned Modules
1 PS 407 10V

Monitor oty

Delete Del

3 CPU 410,

Displays properties of the sele

Change Access 3

Specihy Motz . _>|J

Switch to the "Time synchronization" tab.
Select the "Accept time of day on CP and
forward" check box.

Click on the "OK" button to confirm the
setting.

Properties - CP 443-1 - (R0/S5)

SNMP | Web | Disgnostics
General | Addresses | Options Time-of-Day Synchronization | IP Access Protection
~ SIMATIC Mode

J§
Obje - Alt+Return LI
Open Object With... Chr|+A(+0
VA
x|

™ Accept time of day on CP

™ Use comected time
& Mutomatic " From station " From LAN

~NTP Mode

™| Activate TP tine-of-day sprichronization

I= Time-of dey synchrorization o the full minute

™| Accepttime of day fiom nonssnchioized WTR servers
¥ | Forward time of day to station

NIF server addiesses (1P sddiesses]

add .

Edit.
Delete

Time 2gr7e [lGMT +07.00) Berin, Bem. Brussels, Rome, Stockholm, Vienna =

Update interval [secands)
[Riange of values 160 - B5400]

ot |

Save the configuration and compile it
using: "Station > Save and Compile...".

Close the HW Config.

PCS 7 Minimal Configurations
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3 ES/OS Single Station

3.3 Step-by-step configuration

Creating a PC station
The PC station is created in the PCS 7 project that represents both the ES and the OS.

Step Activity Screenshot
1. In component view, open the shortcut menu =Iolxi
. " . Fle Edit Insert PLC View Options Window Help
of the project and use "Insert New Object > O 8] 5 & | dao 2] = [<Me Fer>
SIMATIC PC station" to add a new PC
station. Tma . mes
. @ K5 MP. Ctrl+alt+0
Gt Chrl4
Copy. (a0
Paste Chrl+Y
Del.
SIMATIC 400 Station
SIMATIC 300 Station
Other Station
PCS 7 License Information. . SIMATIC S5
Shared Dedarations » PalPC
Plant Hierarchy » :L[)HBUS
SIMATIC BATCH » Industrial Ethernet
Rename e
Object Properties. .
Inserts SIMATIC PC Station at the curser pesition, PR TEER ET 4
2. Use the shortcut menu to open the object ~=lojxl
t.eS Of the PC Station File Edit Insert PLC View Options Window Help
propert : 029 & B e e[ %)% (= <o ter>
==l K1_MP Configuration
-8 KI_MP_Pi
451
. Y=} *C Station|
L KI_MP_Lib Open Object Crl+Alt+0
Cut Cirl+x%
Copy cl+C
Haste: Chrl+y.
Delete Del
PLC »
Access Protection 13
Print. 3
... Alt+Return
Displays properties of the selected object for editing. 4
3. Change the name of the ES PC station to [
match the name of the local computer on the Generl | Setngs | Corfigurason |
network' Name: [Esvar
Select the “Computer name identical to PC Sl - MPPINSIMATIC PC Siton(?) =
station name” checkbox. Storage ocation KL E
of the project: =
Author [
Date created 10/12/2017 02:25:19 PM
Last modified 10/12/2017 02:25.19 PM
Comment. =]
-]
Computer name
¥ Computer name identical to PC station name
Computer name: ESval
Cencel Hep
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3 ES/OS Single Station

3.3 Step-by-step configuration

Step Activity Screenshot
4., Open the HW Config of the PC station via the JT= e
File Edit Insert PLC View Options Window Help
shortcut menu. N2 5 DR do %)%=
E¥ K1_MP (Component view) -- D:\Mininimal\Projects\K1\1_MP_MP_\1_MP_MP
Object name
Ctrl+Alt+0
uf il
%_al:lrii Declarations E;W Etr‘ﬁ
Faste ]+
Delete el
Access Protection
SIMATIC BATCH
Rename
Opens selected object. 4
5. Insert a "WinCC application” and a network = (D) PC
card of type "CP1623" from the object catalog q WnCC Bl B
(View > Catalog). 2 CP 1623
3
4
= 1.
5
7
8
9
10
11
12 =l
6. Under “Subnet”, choose the plant bus or [X]
create it by clicking on the “New..." button. Generd  Parancters |
Assign the corresponding MAC address to il
the CP1623. e
Deselect the "IP protocol is being used" e .
checkbox. e B D
ubnet mask:
Click on the “OK” button to confirm your Gy
settings. e
Subnet:
— not networked — New...
Properties..
Delete
Cancel Help
PCS 7 Minimal Configurations
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3 ES/OS Single Station

3.3 Step-by-step configuration

Step

Activity

Screenshot

7.

Open the shortcut menu of the CP1623 and
select "Object properties...".

0) FC

Copy Ctrl+C
Paste CErl

Replace Cbject. ..

Add Master System

Disconmect Master System

IMaster Systemn Isochranous Mode
Insert PROFINET I8 Systenm
Disconnect FROEIMET IO System
PROFIMET ICr Danmain Managerment. . .
PROFIMET IO Tapalagy ..

PROFIMET) IO Isochironous mode

Specity Module, ..

Delete Del

Go To
Filter Assigned Modules

IManitarMadify:

Edit: Symbals, .,

Object Proper
@pen Ohject With, .,
Change Access

Alt+Return
Chrl+-aE+0

Switch to the “Options" tab and select the
"Time of day” checkbox.

Click on the "OK" button to confirm your
selection.

Properties - CP 1623

General | Assignmert  Options | Diagnostics |

Time-of-Day Syr
o

Haster (time sender]

& Slave tims recsiver)

I | fitivate (30 seconds)

"Send Keepalives for Connections:

Seftings for TCP prot
’7NDIS IP address

Use the "Station > Save and compile..." menu
item to save the configuration and compile it.

Close the HW Config.

PCS 7 Minimal Configurations
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3 ES/OS Single Station

3.3 Step-by-step configuration

Configuring the PC station
The "Configure PC station" function transfers project configurations to one or more

target stations.

the “Object properties”, the system
displays directly in the component
configurator the target PC to be
configured.

Using the "Display..." button, you can
display the current configuration of the PC
station.

Click on the “Configure...” button.

Step Activity Screenshot
1 Configure the Station Configuration Editor L e T =10
. B . (@] File Edit Insert PLC View Options Window Help ==l x]
of the ES. To do this, highlight the PC D3| 5757 | % Ba i g |2 2 2 '+ i <o Fiter >
station of the ES and then choose 3] g{r: e Obiect name | 5mbolic name | Type i
" . " : _MP_Pri @l Configuration PL station confi
PLC > Configure..." in the shortcut menu. P o [FPTEE
WinCC Appl WInCT Applicati
CF 4431
%%’ Open Object Ctrl +Alt+0
B ot ctrl+x
e o e
Delete Del
ourioad st
oo * ™ Gomplie and Dowrload Objects...
Print. » Compare... I
SIMATIC BATCH »
Rename F2
Object Properties... Alt+Return
‘ i
Configures a selectable target computer according to the structure or the selected PC station (initialjreconfigure 7
2. Under "Accessible computers:” choose the X
PC that you want to configure. .
Local network connection:
Terminal bus j
NOTE !
If you chose the option "PC name identical . _ Wpdate |
X " I N Accessible computers:
to PC station name" for the PC station in =

¥ Use configured computer name

Target computer:

|E5ve1

Dizplay... |

Merzages:

Cloze | Help |

PCS 7 Minimal Configurations
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3 ES/OS Single Station

3.3 Step-by-step configuration

message: "Transfer completed
successfully."

Close the configuration dialog.

Step Activity Screenshot
3. In the window that appears, you can see Ed
how the PC station is configured. Statior ESVel
Click on the "OK" button to confirm this. [ index [ Name [Type [ status[ Cause =l
1 E WARCE Appl WnCC Appl
2 E CP 1623 CP1623
3
4
5
[}
7
g
9
10
1l
12
12 .
o | o
@ The configuiation is possible. The configuration can be seen in the [ist
above.
Cancel | Help
4. Click on the "OK" button to confirm the [iniormation x|
information dialog.
If the component configuration is changed, the entire PC station
l % wil be reconfigured and the existing database is lost.
~ This can take several minutes,
Make sure that no communication or diagnostics is active over a
compenent in the current configuration.
o |
5. In the bottom window, you then see the X

Local network connection:

I Terminal bus j

Update |

Accessible computers:
ESwWE1

¥ Use configured computer name

Target computer:

[Esyst
Canfigure.. | Dizplay... |
Merzages:

Canfiguration runming.

ESWET:

Transfer completed successfully,
Configuration completed.

Help |
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3 ES/OS Single Station

3.3 Step-by-step configuration

Configuring and loading AS-OS communication

In the following section, the connection is configured using NetPro and loaded in
the stations.

Note In the case of a granular station configuration, you must merge the subnets of
the individual sub-projects first.

Step Activity Screenshot
1. Open NetPro. HzNetPro - [K1_MP_Prj (Network) -- D:\Mininimal =]
. . . . . 98 Network Edit Insert PLC View Options Window Help = x|
Highlight the WinCC application of the ES S8 (S e A TP D N
and open the shortcut menu. Choose =
"Insert New Connection".
Highlight »
Download to current project 3
Rearrange
PlantBus Object Properties. .. Alt+Return
Industrial Ethern#
AS1
i = TR
mm m m
2
4 | Ll_l
J Inserts a new connection in the connection table. 4
2. In the "Connection Partner" window, select x|
the CPU of AS. — Connection Partrner
Make sure that an “S7 connection” is =[] In the curent project
selected under “Connection”. - =8P KI_MP_Ri
: " " 3 =5
Click on the "OK" button to confirm your ' '
selection.
- &l broadeast stations
- &l multicast stations
@ In the multiproject; K1_MP
@ In unknown project
. e
Praject: JKA_MP_Prj =
Station: IAS‘I
Module: |CPL 410-5H
r— Connection
Tvpe: IS? connection j
W Display properties before ingerting
ak. I Apply Cancel | Help |

PCS 7 Minimal Configurations
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3 ES/OS Single Station

3.3 Step-by-step configuration

Step Activity Screenshot
3. On the “General" tab under "Connection 5
identification”, change the “Local ID:" to a Gorord |52 el :
descriptive name like AS1, for example. e e
Click on the "OK" button to confirm your IS empsnedet o end bt
I¥ | Establish an active connestion VFD Name:
entl’y. ™ Send operating mode messages F"ﬂcc'%ﬂ'
1~ Connection Path
Logal Partner
EiRm: s\fswr‘(ﬂaé/ﬂpp\ |§L’4105H
Inteface [cr 1623 x| [cpaa31.Pi-ORL/SE) =
Subnet [PtantBus [indusiral Ethemet] [PrantBus lindustrial Ethemet]
Address Jovoc-2359EF-27 Jos-00-06-01-00-00
Address Details.
= Hep
4. | save and compile by means of: x|
“Network > Save and Compile...". o
. . amplle
Select "Compile and check everything". - .':' _ -
Click on the "OK" button to confirm your * [omele and check eventhing
selection. " Compile changes anly
(1] 4 I Cancel Help
5. Highlight the ES and download the | e pTET
connection via the shortcut menu: S8 % & B a8 o0 Bl K
"Download to current project > Selected !
Stations". |
Download the AS in the same way. & = T
[
Then, close NetPro. | pekee od
— ST
PlantBus Object Properties. Alt+Return
Industrial Ethernet
AS1
| |
‘| ‘H
2
a| | _>l;I
| Downlozds the selected stations (HW data, connection data, gatenay dats). PCinternal.local.1 | 7

Compiling and loading the user program

Compile the S7 program and download it to the AS.

Compiling the OS project
Compile the OS project in SIMATIC Manager.

PCS 7 Minimal Configurations
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3 ES/OS Single Station

3.3 Step-by-step configuration

3.3.2 OS configuration
Step Activity Screenshot
1. Open the OS project. Inlil

In the open WinCC Explorer, highlight the
OS project and choose “Properties” in the
shortcut menu.

= WinCC Explorer - Dt

J File Edit WView Tools Help

L
i
s

“s'||—'l.

..... I Tag Management

..... Mt Graphics Designer

----- ;i‘]' Alarm Logging

----- 3] Tag Logging

a Report Designer
EN] =

----- J v Blobal Script

Text Library

----- 5 Text Distributor

----- 'i'}i‘ User Administrator

----- 5ig Cross-Reference

----- @ Redundancy

----- J_U User Archive

----- L:I Time synchronization

----- ﬁi Picture Tree Manager
L1 Lifebeat Monitoring

14 H

----- *,, 05 Project Editor

g% SFC

----- P web Navigator

Press F1 for Help.

----- J _| Component List Editor

PCS 7 Minimal Configurations
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3 ES/OS Single Station

3.3 Step-by-step configuration

Step

Activity

Screenshot

2.

On the “General” tab under “Type:”,
choose "Single-user project".

Click on the "OK” button to confirm your
selection and the message that the system
then displays.

Project Properties 1'

Operating Mode | User Interface and Design |
General | Update Cycles I Shortcuts I Options

General data of the cument project.

Single-User Project j

Type:
Creator: I";'u'inCC-Projed-Manager

Creation date: |12.-"1 ‘2014 1:45:22 PM

Changed by: IWinCCmejedfManager

Last change: |12.-'1 6/2014 2:23:36 PM

Version: I
GUID: CC_OS_1_14_12_16_13_45_21

Comment: d

0K | Cancel |

Project Properties 1[

@=% A change from a multi-user to a single-user or WinCC dient project
'\ y will delete all configured dient computers from the computer list.
—  Click on <OK> to perform this change,
or on <CAMNCEL > to keep the multi-user project.

OK |

On the "Options" tab, select the "Allow
activation on the ES" option.

NOTE

When using PCS 7 V9.0 and above, the
"Allow activation on the ES" option is
automatically selected and grayed out if
you have not configured a “Path to the
target OS computer”.

5I
|

Operating Mode I User Interface and Design
Gerersl |  UpdateCycles |  Shortcuts Options

Additional project options

[ Help available in Rurtime
¥ Color conversion when printing messages
¥ Export text files as Unicode

[~ tultiuser enginesting

Fesources |

C scripts with language setting "Dynamic” in Runtime:

Operating system language for non-Unicode programs j

This option disables the project activation intedock on the ES.

OK I Cancel

PCS 7 Minimal Configurations
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3 ES/OS Single Station

3.3 Step-by-step configuration

startup list being deleted.

Step Activity Screenshot
4. Click on the "No" button to prevent the x|

-

| The project type was changed.
" Do you want to delete the startup list?

Yes |

5. Open the "Time Synchronization" editor.

Select the "Synchronization via System
Bus (Master, Slave)" checkbox.

Under "Access point 17, choose
“CP1623(1SO)” and select the "Master”
radio button.

Click on the "OK" button to confirm your

G Time Synchronization - [05_Server.mcp] ﬂﬁl

— General Settings

Ok
™ Use time receive utiliy \—I

™ Deactivate time synchronization Cancel

— Swnchronization via Teminal Bus [Slave]
€ Wse the time from & connected WWinCC sever

= Use the time from & specific computer:

The changes do not take effect until you
have closed and reopened WinCC
Explorer.

: Lamputer 1 .
selection. paili| [
Camputer 2: | J
= et time be set by external [3rd - party] components
—¥ Sunchronization via Spstem Bus (Master, Slave)
Access point 1
' Mash
[crigz3ns0) =] Sster
" Slave
~ Access point
1 st
<Moner j =
© Glaye
I Display spmbolic name of the access point
i~ Process contralling messages Project documentation—
V' Send once Pint
Send every _l: minutes ﬂl
Setup
6. Close WinCC Explorer.
NOTE
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3 ES/OS Single Station

3.3 Step-by-step configuration

3.3.3 Activating runtime

After the OS project has been closed, open it again and activate runtime.

3.34 Particularities when loading OS project changes

If the OS and ES are operated on a single PC, you do not need to carry out a
loading operation because all the required data is already available. In this case,
you only need to run the "Compile OS" function.

In a similar way to the "Download changes" function, you can run the "Compile changes
function in the Single Station without exiting process mode in the OS.

PCS 7 Minimal Configurations
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4 ES/OS Client and OS Server

4.1 Configuration description

4 ES/OS Client and OS Server

4.1 Configuration description

In a server-client structure with only two computers, the ES is used as an OS client

at the same time. Three PCs should be provided in this configuration.

Terminal bus

ES/OS Client

Plant bus

\ﬂ\

OS Server

i

PCS 7 configuration

_ SIMATIC Manager - K2_MP_MP

Eile Edit Insert PLC View Options Window Help

=

1l

To

AS

D= (89&| s =2 | dalo &2 =

% K2_MP_MP (Component view) -

)
»

B[] WwAnCC Appl [
-8 ESval

@[] winCC Appl
=8 5

@[] WAnCC Appl. —

] Shared Declaratio -
S Ll_l

- Dx\Mininimal\Projects\K2\K2_MP_MP\K2_M_MF

| Epra_mr_pi
@2 MP Lib

=-{aa] K2_MP_MP
=P K2_MP_Pyi

[#1-{_7] Shared Declarations

Press F1 to get Help.

K2_MP_Prj

@2 MP Lib

PCS 7 Minimal Configurations
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4.2 Required hardware and software licensing
4.2 Required hardware and software licensing

Hardware

For this configuration, we recommend using the hardware below which you can
order via the Siemens mall. This ensures that the appropriate number of selected
operating systems and SIMATIC PCS 7 system software packages are pre-installed
on the PC stations.

Station Product designation Operating system Plant bus
transition
1 x ES/OS SIMATIC PCS 7 ES/OS IPC847D Windows 7 RJ45
Client BCE Network card
SIMATIC PCS 7 ES/OS IPC847D IE | Windows 7 CP 1623
1 x OS Server | SIMATIC PCS 7 ES/OS IPC847D Windows Server 2012 R2 | RJ45
BCE Network card
SIMATIC PCS 7 ES/OS IPC847D IE | Windows Server 2012 R2 | CP 1623

Software licensing

The following section lists the software/license packages that you need for the
selected configuration.

Depending on the project size, an OS server can provide up to 12,000 POs with

the corresponding software package. In addition to engineering software, OS client
software must also be installed on the ES.

Component Software/licence packages

ES/OS client e SIMATIC PCS 7 AS/OS Engineering Software (PO unlimited)
e SIMATIC PCS 7 AS Runtime License
e SIMATIC PCS 7 OS Software Client

OS Server e SIMATIC PCS 7 OS Software Server
e SIMATIC PCS 7 OS Runtime License

PCS 7 Minimal Configurations
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4 ES/OS Client and OS Server

4.3 Step-by-step configuration

4.3

Note

43.1

4.3.2

Step-by-step configuration
The following instructions have been drawn up based on Windows 7 and

PCS 7 V9.0.

CP1623 are used as an example of the plant bus transition. Time
synchronization is activated.

The PC stations used in the test setup are called:

e ES/OS client: ESV81
e OS server: SV

Preparatory activities

Create a project folder on the OS server and share it. This allows the OS data
configured on the engineering station to be transferred to the OS server.

ES configuration

Creating the multiproject

As the basis for the following instructions, all of the PC stations must be physically
networked as shown in the illustration on page 28. Apart from this, you must create
a multiproject on the ES in which the hardware and software of the AS are already
configured.

Then, you start with the following CPU and CP settings.

PCS 7 Minimal Configurations
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4 ES/OS Client and OS Server

4.3 Step-by-step configuration

AS settings

This example describes a way in which the OS server specifies the master time.

Note More time synchronization options are described in detail in the following
manuals:
e "SIMATIC PCS 7 Operator Station (V9.0)"
https://support.industry.siemens.com/cs/ww/en/view/109746516
e "SIMATIC Process Control System PCS 7 Time Synchronization (V9.0)"
https://support.industry.siemens.com/cs/ww/en/view/109746544
Step Activity Screenshot
1. Open the HW Config for the AS. =lol|
. hl ht th CPU d h "Ob' t Olj Station Edit Insert PLC View Options Window Help =12 x]
Highlight the CPU and choose "Objec [De-8 %5 Rme da Do
properties..." in the shortcut menu. =
[ cPU 410-5H
Copy Ctrl+C
Paste ol
IF L | InsertmultisContraller Device
IF2
X5 PNIO-X5 Replace Object...
XS5PIR Port T Add Master System
X5P2R Poit 2 [Misconneck Master System
X8 PNHIO-XE Master System Isochronous Mode
X8PIR Port 1 Inisert PROFINET IO System
XEPZR Port 2 Disconnect PROFINET 10 Systern
35 HiF CP 443-1 PROFINET 10 Domain Management. .
X1 PO FROFINET 10 Topclogy. .
X1PIR Pod 1 PROFINET 16 Multi-Controller Devices, ...
;W D it PROFINET 16 Isochrongus made
= Specify Madule,, .
Delete Del
GoTo »
Filter Assigned Modules
[anitor/Madify.
Edit Symbols...
Object Properties. .. Alt+Return lJ
A SS::g:h;:te::Ithm Ctri+Al+O 5 1
:l:l [0) URZALU Assign AssetID...
Slat Module Product Support Information Ctrl+F2
';— s 1
! Fe 47Tt ::3 Manual E:Iﬁ;
3 CPU 410-5H SIMATIE FOM. »
- Start Device Tool
Displays properties of the selected object for ediing. 4
2. Switch to the "Diagnostics/Clock" tab. Praperties~CPUA IS IERES) X
In the "Clock" section, set "As slave" for — Eﬁi’f{’;‘;::m“u'agniif;‘)éﬂe'"’i”plte:::""f | pienwt |
the AS under “Synchronization Type”. ~Sysen D
Click on the "OK" button to confirm your EEEEEEs
| tiOI"I ¥ Report cause of STOP
selec b ™ Acknowledgment-triggered reporting of SFB33-35
Number of messages in the diagnostics buffer W
~Clock
Synchronization ‘Synchronization Type Time Interval
Inthe PLC. [s slave =] [Mere =l
Tt WP [one =] [rione =
Ori the ME; [None ] [Nere =l
Comection factor: lu— ms
Cancel Help
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4 ES/OS Client and OS Server

4.3 Step-by-step configuration

Step

Activity

Screenshot

3.

Open the shortcut menu of the CP and
select "Object properties...".

D" &g ae dal S8 e

[ HW Config - [AS1 (Configuration) -- K2_MP_Prj] - o) x|
E“]Staﬁoﬂ Edit Insert PLC View Options Window Help - ﬂﬁl

i) URZALD
1 PS 407 10A B
3 CPU 4105H
X §or
IF1

Copy cirl+C
Paste |+
Insert Multi-Cantraller Device

El Replace Object...
| AddMaster System
Disconnect Master System
[Master System Tsochronous Mode
Insert PROFINET I8 Systen
Disconmect PROFINET 10 System
PROFINMET IO Dornain Mansgement.
PROFINET 12 Tapalagy..
PREFIMET I Mulki-Contraller Devices, ..
PREFIHET I Isachroneus mode:

0
0] URZaLU
:I:I o GoTo »

Slot Module  Filter Assigned Modules
1 PS 407 10V

Monitor oty

Delete Del

3 CPU 410,

Displays properties of the sele

Change Access 3

Specihy Motz . _>|J

Switch to the "Time synchronization" tab.
Select the "Accept time of day on CP and
forward" check box.

Click on the "OK" button to confirm the
setting.

Properties - CP 443-1 - (R0/S5)

SNMP | Web | Disgnostics
General | Addresses | Options Time-of-Day Synchronization | IP Access Protection
~ SIMATIC Mode

J§
Obje - Alt+Return LI
Open Object With... Chr|+A(+0
VA
x|

™ Accept time of day on CP

™ Use comected time
& Mutomatic " From station " From LAN

~NTP Mode

™| Activate TP tine-of-day sprichronization

I= Time-of dey synchrorization o the full minute

™| Accepttime of day fiom nonssnchioized WTR servers
¥ | Forward time of day to station

NIF server addiesses (1P sddiesses]

add .

Edit.
Delete

Time 2gr7e [lGMT +07.00) Berin, Bem. Brussels, Rome, Stockholm, Vienna =

Update interval [secands)
[Riange of values 160 - B5400]

ot |

Save the configuration and compile it
using: "Station > Save and Compile...".

Close the HW Config.

PCS 7 Minimal Configurations
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4 ES/OS Client and OS Server

4.3 Step-by-step configuration

Setting up the ES PC station

To be able to test the OS project on the ES, create a PC station for the ES using

the WIinCC application.

Step

Activity

Screenshot

In component view, open the shortcut
menu of the project and use "Insert New
Object > SIMATIC PC station" to add a

new PC station.

Sll'-lATJC Manager - K2_MP_MP

File Edit Insert PLC View Options Window Help

=] ]

N [Bia )8 e a2 %2 =

|[ < Mo Fiter >

" K2_MP_MP (Component view) -- D:\Mininimal\Projects\K2\K2_MP_MP\K2_M_MP

) @l KZMPME AS1
B I Gpen Object Ctl+Alt+0
@ K2 MP_Li
ut ity
Copy Cilic
Peste iy,
Delete el

Multiproject

SIMATIC 400 Station
»  SIMATIC 300 Station

PLC »  SIMATIC H Station
SIMATIC PC Station

Access Protecton Other Station

PCS 7 License Information... SIMATIC S5
PGJPC

shared Dedarations 3

) MR

Plant Hierarchy " proFBUS

SIMATIC BATCH »  Industrial Ethernet
PTP

Rename F2 Foundation Fieldbus

Chject Properties. . Alt+Return

57 Program
Preconfigured Station...

05
05 (Client)

Shared Dedarations

Use the shortcut menu to open the object

properties of the PC station.

File Edit Insert PLC View Options Window Help

Batch process cell
Project Documentation
Inserts SIMATIC FC Station at the cursor position. 4
2 [ SIMATIC Manager - K1_MP =1oix]

£3 K1_MP (Component View) -- d:\K1_MP

Configuration

Open Object

Cut

Copy
Paste:

Delete

PLC

Access Protection
Print.

Rename

D& (88 & B Rk 2 %) %[

Ctrl+Alt+0

Crl+X
crl+C
el

Del

F2
Alt+Return

Change the name of the ES PC station to
match the name of the local computer on

the network.

Select the “Computer name identical to

PC station name” checkbox.

Displays properties of the selected bject for editing. 7
Properties - SIMATIC PC Station ﬂ

General | Settings | Configuration |

Name [Esver

Project path; K1_MP_P{\SIMATIC PC Stati

on(1) il

Storage location KI_MP_Pr
of the project

Author: |

Date created 10/12/2017 02:25:19 PM

Last modified 10/12/2017 02:25:19 PM

Comment: =]
Computer nam

[V Computer name identical to PC station name

Computer name: ESVET

Cancel Help
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4.3 Step-by-step configuration

Step Activity Screenshot
4. Open the HW Config of the PC station via ﬂ'-m'-'a-aﬂﬂ-ﬂuuv L =lolx|
File Edit Insert PLC View Options Window Help
the shortcut menu. [C@ (] % & e d]o % Tevories
[ K2_MP_MP (Component view) -- D:\Mininimal\Projects\K2\K2_MP_MP\K2_M_MP
== K2_MP_MP
=8 K2 MP_Py Open Objec Cirl+Alt+0
A5 T
ESvaT Gt (CEr| %
Shared Declarations || -2 dikic
g KZMP_Lib Paste |+,
Delete Del
Access Protection »
SIMATIC BATCH »
Opens selected object. Rename F2 4
5. Insert a "WinCC application” & (0) PC
(and a network card) of type “CP1623" q WnCC Bopl, B
from the object catalog (View > Catalog). 3 CP 693
3
4
3 .
[
7
3
9
10
11
12 =]
6. Under “Subnet”, choose the plant bus or [X]
create it by clicking on the “New..." button. Generd  Parametes |
Assign the corresponding MAC address to il
the CP1623. e
Deselect the "IP protocol is being used" Ll e
checkbox. eS| i —
. “ 1 . S ) Wse router
Click on the “OK” button to confirm your e ———
settings. ——
— not networked — New..
Properties...
Delete
= Help
7. Open the shortcut menu of the CP1623
and select "Object properties...".
3 I Copy ctrl4C
4 Paste Chrlii
5
5 | Replace Object...
7 [ addiMasker System
2 | Disconmect Master System
9 || Master System Isachronous Made
10 || Insert PROEINET 10 System
i || Disconnecs FREFINET I System
12 FROFINET 10 Domain Management..,
FROFIMET I Topalogy. .
BROFINET [0 Isochronous mode
Specity Madule. ..
Delete Del
GoTo ]
Filter Assianed Modules
IMonitar/Madify:
Edit Symbals, ..
Object Properties... Alt+Return
Open Object With, .. Chrl Ao
Chiange Access 3
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menu of the project and use "Insert New
Object > SIMATIC PC station" to add a
new PC station.

Step Activity Screenshot
8. Switch to the “Options" tab and select the =]
Optionally | "Time of day” checkbox. ) [ e =
Click on the "OK" button to confirm your e
selection I ——
NOTE % Slave ftime recsiver)
You do not need to activate Time of day of { f;":f‘*':'m”d] ‘
the CP 1623 for an ES/OS client _
combination, since time synchronization of S TR ErE
the OS client is configured via the terminal [”D‘S'PE"““ ‘
bus.
e Help
9. Save and compile using the "Station >
Save and compile..." menu item.
Close the HW Config.
10. In SIMATIC Manager, delete the OS
Optionally | application of the ES PC station, since it is
not needed in our example.
Setting up the OS server PC station
Step Activity Screenshot
1. In component view, open the shortcut =lalx]

File Edit Insert PLC View Options Window Help

N[22 % B ] %=

|[ < Mo Fiter >

23 K2_MP_MP (Component view) -- D:\Mininimal\Projects\K2\K2_MP_MP\K2_M_I

i Open Object Clri+AIt+0
Cut Chrl+%
Copy Cirl4C
Faste Chrl+Y
Delcte el

SIMATIC 400 Station
Multiproject. > SIMATIC 300 Station
PLC

Insert New Object

Access Protection

PCS 7 License Information... SIMATIC 55
PGJPC

Shared Dedarations >

- , M
Plant Hierarchy RrTELE
SIMATIC BATCH »  Industrial Ethernet
=== = Foundation Fieldbus
Chject Properties. . Alt+Return

57Program

05
05 (Client)

Shared Dedarations

Batch process cell

Project Documentation

Inserts SIMATIC PC Station at the cursor position.

Preconfigured Station...
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Step Activity Screenshot
2. Use the shortcut menu to open the object ﬂil
. - %] File Edit Insert PLC View Options Window Help =8| x
properties of the PC station. D@87 e o % e et rters
=zl K1_| Configuration
=]
IR 2T IC -
- KI_MP_Lib Open Object Cirl+Alt+0
Cut Cirl+x%
Copy crl+c
Paste: Chrl,
Delete Del
PLC »
Access Protection »
Print »
Rename F2
Displays properties of the selected object for editing. v
3. Change the name of the OS server PC S
station to match the name of the computer General | seings | Confguation |
on the network. Name [v
Select the “Computer name identical to PC R LT =
station name” checkbox. Sregs e TP =
of the project: r - Z’
Author. ||
Date created: 1041272017 02:25:19 PM
Last modffied: 1041242017 02:30:47 PM
Comment: =l
-]
Computer name
[ Computer name identical to PC station name
Computer name: SV
s Help
4. Open the HW Config of the PC station via JR=TE
h hortcut menu File Edit Insert PLC View Options Window Help
the s - EEEEEL I EERE <o Fiter>
£® K2_MP_MP (Component view) -- D:\Mininimal\Projects\K2\K2_MP_MP\K2_M_I
=-{en] K2_MP_MP
=8P K2_MP_Pyj
L= Chrl
Copy. 4G
{20 Shered Declaations | | 2" Sl
@ K2 MP_Lib Delete De!
Access Protection »
SIMATIC BATCH »
Opens selected object. Rename: F2 4
5. From the object catalog
("View > Catalog”), insert a "WinCC A GG R, B
application" and a network card of type 3 CP 1623
"CP1623". E)
4
5 -
&
7
B
9
10
11
12 hd|
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Step Activity Screenshot
6. Under “Subnet”, choose the plant bus or [X]
create it by clicking on the “New..." button. Generel  Paremeters |
Assign the corresponding MAC address to il
the CP1623. e
Deselect the "IP protocol is being used” W P (i e
checkbox. eS| i —
Subnet mask cu .
Click on the “OK” button to confirm your S
settings Y —
I g : Subnet:
— not networked — New...
Properties...
Delete
= Help
7. Open the shortcut menu of the CP1623
and select "Object properties...".
3 _: Copy Cirl+C
4 Faste bl
5
5 | Replace Object...
7 [ &dd|Masker System
2 | Disconmect Master System
9 || Master System Isachronous Made
o || Ifiserk PROFINET & System
i || Disconnecs FREFINET I System
12 FROFINET 10 Domain Management..,
FROFIMET I Topalogy. .
BROFINET [0 Isochronous mode
Specity Madule. ..
Delete Del
GoTo ]
Filter Assianed Modules
IMonitar/Madify:
Edit Symbals, ..
Alt+Return
Chrl Ao
Chiange Access 3
8. Switch to the “Options" tab and select the =]
"Time of day” checkbox. Gonera | Asigrment Opton | Diagrosis |
Click on the "OK" button to confirm the
setting.
% Slave fime receiver)
Send Keepalives for Connection:
’VIV Activate (30 seconds) ‘
Settings for TCP prot
IVNDIS IP address ‘
Cancel Help
9. Save and compile using the "Station >
Save and compile..." menu item.
Close the HW Config.
PCS 7 Minimal Configurations
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Step Activity Screenshot
10. In SIMATIC Manager, open the properties ]
dialog of the OS server's OS project. Genersl Targel 05 and Standby 05 Computer |
Switch to the "Target OS and Standby OS Path o the Target O Comper
Computer" tab. I Search .
Under "Standby OS”, choose <none>. Symbolic computer name
Then, click on the "Search..." button. v
Standby QS
[<rone > =
¥ Create/update archive tags
[~ Transferto extemal archive server
11. Use the drop-down list to navigate to the = =]
Shared prOJeC'[ folder Of the OS server jvl vNellwﬂrkv SV - Projects - OS_Server ~ 23| search 05 server %
o e File name: | 03_Server.m: =
(see 4.3.1 Preparatory activities). I 3
Click on the "Save" button.
A
12. In the input field, check the "Path to the |
Target OS Computer”. Gonersl Taree 05 and Standby 05 Computer |
Clear the “Transfer to external archive Path to the Target O Computer
server” checkbox if you are not using a [\\5V\Projects\05_Server\0S_Server mep T
Process Historian. Symbolic computer rame
Click on the "OK" button to confirm this. [5v
Standby QS
[<rone > =
= cone
13. Click on the “Yes” button to confirm the |
information dialog.
After changing the target path or after assigning a standby 05,
r l %, the online modification capability gets lost.
Additionally, the OS5 needs to be newly compiled, the packages for
the dients are to be updated and an entire loading
of all assigned OS5 servers needs to be executed.
Do you wish to execute the changes?
Yes Mo |
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Setting up the Client PC station

menu of the project and use "Insert New
Object > SIMATIC PC station" to add a
new PC station.

Step Activity Screenshot
1. In component view, open the shortcut 5‘““'"" == =Fx

~ @@ o ]
Dw 8% 4 e da[2 %)% =% |
£33 K2_MP_MP (Component view) -- D:\Mininimal\Projects\K2\K2_MP_§ o [ |
[E] K2_MP_MP
5 o s
iy Open Object Cirl+Alt+0
LSV Chix,
By ChrC
D sha e Gl
@ K2_MP.
Delete 0
jec [ SIMATIC 400 Station
Multiproject »  SIMATIC 300 Station
PLC > SIMATIC H Station
ccess Protacton M| SIMATICPC Stztion
Other Station
PCS 7 License Information... SIMATIC 55
I £ =T
Shared Dedarations »
bty o
Plant Hierarchy T
SIMATIC BATCH »  Industrial Ethernet
N 1
Rename 2 Foundation Fieldbus
Object Properties Alt+Retun
57Program
Preconfigured Station. ..
os
0s {Client)
Shared Dedarations
Batch process cell
Project Documentation
Inserts SIMATIC FC Station at the cursor position 4

2. Use the shortcut menu to open the object
properties of the PC station.

~inix]

File Edit Imsert PLC View Optons Window Help

D |87 4 B2 bl %%
[ K2_MP_MP (Component view) -- D:\Mininimal\Proj
=) K2_MP_MP

Configuration

-8 K2 MP_Fi [ winCC Apal. Cliert
: @ A1
=)
& ES' Open Object Cirl+Alt+0
SV
Cut Cirl4X
%' 1?4:‘:: Copy ctrl+C
]
= Faste. CEr
Delete Del
PLC »
Access Protection »
Print 3
SIMATIC BATCH »
Rename F2

Displays properties of IS i et T y.

3. Enter a freely selectable name under
"Name".

Under "PC name:" enter the name of the
PC on which you intend to operate the
client. In the present configuration, this is
the ES PC.

Click on the "OK" button to confirm your
entry.

Properties - SIMATIC PC Station

General | Settings | Cortiguration |

I

Name: JeL
Project path: K2_MP_PG\CL ﬂ
Storage location D:\Mininimal\Projects\KZ\K2_MP_MP\K2_M_Pq =
of the project =
Author |
Date created 01/14/2015 03:17:49 PM
Last modified 01/14/2015 03:24:41 PM
Comment: =
|
Computer name
[~ Computer name idertical to PC station name
Computer name: ESVE1

ot | _ren
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Step Activity Screenshot
4. Open the HW Config of the OS client's PC =131
Statlon File Edit Insert PLC View Options Window Help
) D | B0 a| % B el 5% o [[<Mo Fiter >
©% K2_MP_MP (Component view) -- D:\Mininimal\Project =10l =]
E.gg_r;__ a;_ Fi Open Object Ctrl+Alt+0
AS1 Cut: Ghrl
Eévm Capy Gk
5y Paste: CErl+Y,
{2 Shared Declarations Delete el
@ KZ_MP_Lib
Access Protection 13
SIMATIC BATCH »
Rename F2
Opens selected ohject. VA
5. From the object catalog (View > Catalog) () PC
insert a WinCC application client.
1 WinCC Appl. Client -
2
3 L
4
b
6
7
> =
6. Save and compile using menu command:
"Station > Save and Compile...".
Close the HW Config.
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Configuring all of the relevant PC stations

The "Configure PC station" transfers project configurations to one or more target stations.
First of all, configure the local Station Configuration Editor of the ES and then the OS
connected to the plant bus.

Step Activity Screenshot
1. Configure the Station Configuration Editor .ﬂ'“'-'“--'-"'-' —
. ile it Inser iew Optons Window Help
of the ES. To do this, open the shortcut OZ|8 5% B e |5 %)
menu of the ES and choose “PLC >
Configure...". TES i
o fi ASED CP 1623
. BB oe ) P 1623(2)
i - [§ WinCC Appl. Client
= g%ﬁl
e Open Object Cirl+Alt+0
Gl Cut Cirl+x
@ wel o
Delete Del
PLC » Daownload il

Print

Compile and Download Objects...

Rename F2 I
Compare...
Object Properties... Alt+Return

2. Under "Accessible computers:” choose the x|
PC that you want to configure. Local netwark cannection:
Terminal bus ¥
NOTE | -
If you chose the option "PC name identical ' : Update |
to PC station name" for the PC station in CEERCHLS COTELES
the “Object properties”, the system ES,VE”
displays directly in the component
configurator the target PC to be
configured.
Using the “Display..." button, you can show
the current configuration of the PC station.
Click on the “Configure...” button. Tl Uso cemiies Gomm o nume

Target computer:

|ESVB1

Dizplay... |

Messages:

Cloze | Help |

PCS 7 Minimal Configurations
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information dialog.

Step Activity Screenshot
3. In the window that appears, you can see x|
how the PC station is configured. Statian: (EE
Click on the "OK" button to confirm this ‘ndilél;ma | Tope [ status | Cause =
H 1 WinCC Appl. WinCC Appl.
setting. 2 I crigzs CP 1623
3
4
5 | |
3
7
A
]
10
1
12
13 =
4| | _'lJ
@ The configuration is possible. The configuration can be seen in the list
abaove.
Cancel | Help |
4. Click on the "OK" button to confirm the finformabon X

If the component configuration is changed, the entire PC station
' % wil be reconfigured and the existing database is lost.
~ This can take several minutes.
Make sure that no communication or diagnostics is active over a
component in the current configuration.

cos|

message: "Transfer completed
successfully."

Close the configuration dialog.

5. In the bottom window, you then see the

i

Local netwark, connection:
ITerminaI bug j

Acceszible computers: Updatz

ESWET
v

v Uze configured computer name

Target computer:

|ESV81

Dizplay... |

Meszages:

Configuration running.

ESWETL:

Transfer completed successfully,
Configuration conpleted.

Cloze | Help |
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Step

Activity

Screenshot

6.

Configure the Station Configuration Editor
of the OS server as shown in steps 1 to 5.

Configuring and loading AS-OS communication

In the following section, the connections between the PC stations and the AS are
configured in NetPro and loaded in the individual stations.

Note In the case of a granular station configuration, you must merge the subnets of
the individual sub-projects first.
Step Activity Screenshot
1_ Open NetPro. % NetPro - [K2_MP_Prj (Network) -- D:\Mininimal\.—. =10l x|
98 network Edit Insert PLC View Options Window Help =121

Highlight the WinCC application of the ES
and open the shortcut menu. Choose
"Insert New Connection".

S H S ek 8T S Bl R

AS1
: CFU_0F (PN _IFN- [CF FNID
i 4105H | |10-K5 | 10X8 4431 )
L= - i}
2
PlantBus

Industrial Ethernet

-

I

sV

WinCC |CP
Appl. 1623

Highlight 3

Dowrload to current project 3

Rearrange
cL =

[=] [Winci  Object Properties... Alt+Return
==] |~

o
Client

e —

| Inserts a new connection in the connection tzble.
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Step Activity Screenshot
2. In the "Connection Partner" window, select X
the CPU of the AS. — Connection Partner
Make sure that an “S7 connection" is =-{8] In'the curret project
selected under “Connection”. =& K2_MP_Prj
: AL ] =
Click on the "OK" button to confirm your L)
selection.
- All broadcast stations
- Al ulticast stations
[]--@ I the multiproject: K2_MP_tP
@ I unknown project
: e
Praject: |K2_MP_Prj -
Statian: jas1
Fodule: IEPU 410-5H
— Connection
Tupe: IS? connechion j
¥ Display properties before inserting
ak. I Apply Cancel | Help |
3. On the “General" tab under "Connection =
identification”, change the “Local ID:" to a Genr st |
descriptive name like AS1, for example. [ e e e
Click on the "OK" button to confirm your ;gﬂj's_“:dﬁ‘°:ee"d t 'V*‘f[jw
entries. (o ———— W Ao
—Connection Path
Logal Partner
(Eril I?\r‘!fgé/ﬂpp\ Iéglf‘mw
Interface: |cp 1623 | [cp 4231 PrioRO/SE) |
Subnet. [PlantBus [industrial Ethemet] [PlantBus [Industrial Ethemet]
Address [oriE7B-90136% Joe-00-06-01-00-00
Address Details.
= Help
4. Repeat steps 1 to 3 to connect the OS
server to the AS.
When doing this, it is important that the
connections of the ES and the OS server
to the AS have the same name.
PCS 7 Minimal Configurations
02/2018 14
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Step Activity Screenshot
5. In the connection table of the AS, change i NetPro - [Ka_Prj (Network) - D:\Projekte)E I [=] o}
Optionally | the local ID for the connection to the ES to B fctook ot it PC Wow Optons Wndw e =181x]
a value of greater than 0xc00. CAR N T Y T L
Not Plantbus i =l
ote . Industrial Ethernet
A connection ID of greater than 0xc00 T T J
prevents the AS from generating
messages in later operation due to starting = ESVat = SV
or stopping of OS simulation on the ES. hea|zs hea|zs
=] =]
B —
Local ID ‘Partner (o] |Partnar i’
2 AS1 : SWIWiInCC Appl.
| | _>l;I
JReady 4
6. Use th_e ""Network > Save gnd Cpmpile..." x|
menu item to save the configuration and ‘
compile it. - Compile
Select the "Compile and check everything" (" Compile and check everything
option button and click on the "OK" button (~ Comple changes ool
to confirm your selection.
oK | Cancel | Help
7. Select the ES and download the e e -0l
3 . 98 Network Edit Insert PLC View Opfions Window Help =18
connections via the shortcut menu: 8% g ne dad s Dl
"Download to current project > Selected 1 2
Stations". o
Download the OS server and the AS in the 5 I R o
same way. sals| s
Then, close NetPro. PlantBus
Industrial Ethernet
| lsv |
g Open Object Chl+AIt+0
Copy Crl+C
Delete Del
Download to current project Selected Stations
B Selected and Partner Stations l
i{]hje]ct?mpemas. Alt+Return I
4 | o
J Downloads the selected stations (HW data, connection data, gateway data) PCinternalle
Compiling and loading the user program
Compile the S7 program and download it to the AS.
Compiling the OS server project
Compile the OS server project in SIMATIC Manager with selected "Generate
server data" checkbox.
Make sure that you make the correct OS assignment to the server in plant view.
PCS 7 Minimal Configurations
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Assigning the server package

Step Activity Screenshot
1. Highlight the OS application of the OS
client and choose "Assign OS server..." in Fle Edt Insert PLC Vew Opfions Window Feb
the shortcut menu. D (82| 4 B2 din|lo B2 %
E= K2_MP_MP (Component view) -- D:\Mininima
E-{2] k2_MP_MP
=89 K2 MP_Fij
451
=N
: = [ WAnCC Appl Clier
g E.;\IISW Open Object Cirl +Alt+0
CoE-E s
53 Shared D CUE FIE
- K2_MP_Lib Copy EksE
Faste CErY,
Delete Del
PLC 3
Access Protection (3
Compile Ctrl+B
Display load log...
Assign OS5 server...
Print 3
SIMATIC BATCH 3
4 Rename F2
Server-server and/or server- B R AR v
2. Select the corresponding OS project and X
click on the "OK" button to confirm your e T Symbolc computer name |
selection. [Flkz_MP_Pri - O5_Server sv
oK I Cancel | Help
I‘I‘he WinCC project was opened 4
3. Click on the "OK" button to confirm that the
package was loaded successfully.
The procedure was completed without error
]
The procedure was completed without error
AEEEENREENNNRENNENREENNNNENNEDEN
Error | ‘
oK Cance]
i
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4.3.3

OS configuration

Activating time synchronization
On the ES, the necessary settings are activated in the OS projects of the OS

server and the OS client.

Step Activity Screenshot
1. Open the OS server project. 1ol x|
File Edit Insert PLC View Options Window Help
O[3 4 Bl w0 %)% % & | < e Fiter >
E% K2_MP_MP (Component view) — D:\Mininimal\Projec! =101 x|
Bl 2] K2_MP_MF Fr AMT1
-8 K2_MP_Pri M RMT2
= AS1
(23 Shared vl Open Object Cirl+Alt+0
F-&% K2_MP_Lib cut cirl4x
Copy Ctri+C
Paste: Chrl+y
Delete Del
Insert New Object 3
PLC 3
Access Protection »
Compile ctrl+8
Display compilation log...
Display load log...
Generate server data
Assign OS server. ..
Start 05 simulation
Import WinCC objects
Print L4
Plant Hierarchy 3
SIMATIC BATCH 3
Rename F2
Object Properties... Alt+Return
Opens selected object. 4
2. Open the "Time Synchronization" editor 21
from the shortcut menu. ~ Gereral Settings
™ Use time receive utiliy \LI
Select the "Synchronization Via System ™ Deactivate time synchronization Cancel |
Bus (Master, Slave)" checkbox.
Under "ACCESS point 1,,, Choose — Swnchronization via Teminal Bus [Slave]
“CP1 623('80)” and Select the "Master” = Use the time from & connected WinCE senver
radiO button = Use the time from & specific computer:
Click on the "OK" button to confirm your Bt [
selection. Computer 2: | J
= et time be set by external [3rd - party] components
NOTE . . . —¥ Synchronization via Spstem Bus (Master, Slave)
If you configure station time = s i
synchronization on a different computer, [CPiezatn) 5] © Maser
the access points are not known, which  Slave
means that they are not available in the . o
- . [T ACcCess poinl
drop-down list. To choose the access point i € Master
T H N -
regardless, select the "Display symbolic Hener I s
name of the access point" checkbox and
then choose the appropriate access point. " Display symbolic name of the access point
i~ Process contralling messages Project documentation—
¥ Send once Print
Send every _l: minutes ﬂl
Setup
3. Close the OS server project.

PCS 7 Minimal Configurations
Entry ID: 24023824, V7.1, 02/2018

47



© Siemens AG 2018 All rights reserved

4 ES/OS Client and OS Server

4.3 Step-by-step configuration

from the shortcut menu.

Select the "Synchronization via Terminal
Bus (Slave)" checkbox and choose "Use

the time from a connected WinCC server".

Click on the "OK" button to confirm your
selection.

Step Activity Screenshot
4. Open the OS client project. JRT=E
File Edit Insert PLC View Options Window Help
D@‘g?ﬁ|%ﬁlﬁ|’?%|gg:' ||<NOF\|h
£ K2_MP_MP (Component view) -- Dz\Mininimal\Proj -|E| 5[
=izl K2 MP_MP
=P K2 MP_Py
: 451
B
o B[ WinCC Appl Clier
8 Esvel Open Object Chrl+Alt+0
CoE-E sy
: o[ wince Cut Chrl+%
L 05 Copy Crl+C
{2 Shared DE(’ Paste CErl 4
- K2 MP_Lib Delete Del
PLC »
Access Protection 3
Compile Crl+B
Display load log...
Assign OS server...
Print 3
SIMATIC BATCH 3
Rename F2
Object Properties... Alt+Return
4] S |
Opens selected object. 4
5. Open the "Time Synchronization" editor 2|

— General Settings
™ Use time receive utiliy

I Deactivate time synchronization

Cancel |

—w Swnchronization via Teminal Bus [Slave)]
¢ Use the time from a connected WinCC server

i Lze the ime from a specific computer:

Computer 1: I

1

Computer 2 I

" Let time be set by external [3rd - party) components

| Sunchranization wia Spster Bus [Master, Slave]

- Access point 1
I J ) Waster,
-
) Slave
—Access point
= = ffaster
C Glays

™| Display symbolic name of the acesss point

Project documentation—

Frirt
Freview
Setup

r— Process controlling meszages

¥ Send once

Sendevern _I: minutes
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Step Activity Screenshot
6. Select the "Server Data" editor in the 2lx|
WinCC Explorer, and then select the
"Standard Server..." command from the [y Standard server
shortcut menu. Component I Symb. computer name I
Alarms sV
Archives <Mo standard server=
Select the standard server for the Pictures <No standard server>
components "Alarms" and "SSM" (Split S5M s
S Mana er) Taas <MNo standard server >
creen g Text Library <Mo standard server>
User Archives <No standard server =
Click on the "OK" button to confirm your
selection.
OK I Cancel Help
Y
7. Close the OS client project.

Downloading the OS project to the OS server

After time synchronization is configured on the ES side, download the OS project to

the OS server.

project of the OS server and select the
"PLC > Download" context menu.

Step Activity Screenshot
1. In SIMATIC Manager, highlight the OS ~1olx|

File Edit Insert PLC View Options Window Help

D255 & e[ %)% -

[ |[ < No Fiter >

% K2_MP_MP (Component view) -- D:\Mininimal\Projects! -[Of x|

E {75l K2_MP_MP - RMT1
=8P K2 MP_P % RMT2
431

) Shared oy OPen Obet curl+Alt+0

@ K2_MP_Lib cut cirlx
Copy ctrl+C
Paste Ctrity
Delete Del

Insert New Object
PLC

Access Protection

Compile ctl+g

Display compilation log...
Display load log...
Generate server data
Assign O server...
Start O5 simulation
Import WinCC objects

Print >
Plant Hierarchy »
SIMATIC BATCH 3
Rename F2
Object Properties... Alt+Return
Downloads current object to the PLC. i
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project is located in the specified folder on
the OS server.

Click on the "OK" button to confirm the
message that is issued.

Step Activity Screenshot
2. For the first OS project download, an entire =
download iS reqUired- Target system: W\SVAProjects\0S_Servers05_Server.mcp
Click on the "OK" button to start .
. i~ Scape
dOWnload|ng. £+ The entire WinCC project
€ Changes Details
I~ Start compilation before downloading
The entire ‘WinCC project will be tansfered to the runtime 05,
Ok I Cancel | Help
3. After successful downloading, the OS

Download to target system was complated successhully.

Ermar |

£ none ¥

0K Canzel
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4 ES/OS Client and OS Server

4.3 Step-by-step configuration

OS configuration on the OS server

After the first download, check the step instructions below for time synchronization
and correct them if necessary.

Note Normally, all configuration work is carried out on the ES to ensure consistent

© Siemens AG 2018 All rights reserved

data management. This means that no WinCC engineering licenses are needed
on the OSes. However, each time WinCC Explorer is opened, a license-free time
window of two hours is available for WinCC configuration work.

editor from the shortcut menu.

Check or select the "Synchronization via
System Bus (Master, Slave)" checkbox.
Check or select "CP1623(ISO)" and the
"Master" option button under "Access
point 1".

Click on the “OK” button to confirm your
settings.

Step Activity Screenshot
1. Open the OS project on the OS server.
2. Open the "Time Synchronization" 21

 General Settings

™ Use time receive utiliy

— Swnchronization via Terminal Bus [Slave)
€ Wse the time from & connected WWinCC sever

= Use the time from & specific computer:

0K I
[ e |

™ Deactivate time synchronization Cancel

Computer 1: |

Camputer 2 |

= et time be set by external [3rd - party] components

1

—¥ Sunchronization via Spstem Bus (Master, Slave)

Access point 1
' Mast
[crigzsisn) =] aster
" Slave
~ Access point
€ Mast
<Mone> j =
C Glave

™ Display spmbolic name of the access point

Praoject docurmentation——

— Process contralling messages
¥ Send orice Pint
= Freview
Send every _lj minutes
Setup
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4 ES/OS Client and OS Server

4.3 Step-by-step configuration

4.3.4 Activating runtime

Open the OS project on the OS server and activate runtime.
Then, switch to the ES computer and open the OS client project. Activate runtime there too.

435 Particularities when loading OS project changes

Loading changes

Before you can carry out OS compiling and downloading to the ES, OS client runtime
must be deactivated and the OS project closed.

Complete download

Before you can carry out OS compiling and downloading from the ES, OS client runtime
and the OS server must be deactivated and the respective OS projects must be closed.

PCS 7 Minimal Configurations
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5.1 Configuration description

5 ES, OS Master and OS Standby

5.1 Configuration description

During process mode, the pair of Single Stations runs completely in-parallel and
independently from each other. If one of the Single Stations fails, an equivalent,
redundant OS Single Station is always available. The Single Stations monitor each
other during runtime and synchronize the project archives as needed.

For synchronization, the OS Single Stations are connected via a redundant cable. You
can use a network cable on an additional network adapter or a null modem cable on the
COM port as the redundant cable. In the configuration below, a COM cable is used.

Configuration is carried out via the ES.

Hardware configuration

Terminal bus

ES OS Master OS Standby

‘m 0 ‘M ‘“ 0 H Redundancy ‘m n ‘M
—
1 I
Plant bus COM-Cable
T AS
E .U* 1°1 | |
ik
i
Note You need server packages for the function of the MS clients. If the OS/MS server

is set up as a Single Station, the MS client cannot be used on the ES.
The jump keys in the asset faceplate for hardware configuration and for PDM
function as follows:

- Up to PDM V8.1: On ES only

- PDM V8.2 and higher: On ES and OS clients

- PDM V9.0 and higher: On ES and OS clients, and web clients

PCS 7 Minimal Configurations
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5 ES, OS Master and OS Standby

5.1 Configuration description

PCS 7 configuration

_ SIMATIC Manager - K3_MP_MP ;IEIEI

File Edit Insert PLC View Options Window Help

I < Mo Fite

D |8 f B2 dalle 2% =)@

E| WinCC Appl.
. g 05_Master
B sve

=@ winCC Appl (Sthy)
[ :-'_"p 05_Master_StBy LI

=N,

E® K3_MP_MP (Plant View) -- D:\Mininimal N =]

=-{2a] K3 MP_MP - K3 MP_Pij
£ K3_MP_Pi @ K3 MP_Lib
Shared Declarations
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Press F1 to get Help.
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5 ES, OS Master and OS Standby

5.2 Required hardware and software licensing

5.2 Required hardware and software licensing
Hardware
For this configuration, we recommend using the hardware below which you can
order via the Siemens mall. This means that the appropriate number of selected
operating systems and SIMATIC PCS 7 system software packages are pre-installed
on the PC stations.
Station Product designation Operating Plant bus
system transition
1xXES SIMATIC PCS 7 ES/OS IPC847D BCE | Windows 7 RJ45
Network card
SIMATIC PCS 7 ES/OS IPC847D IE Windows 7 CP 1623
2 x OS Single Station SIMATIC PCS 7 ES/OS IPC847D BCE | Windows 7 RJ45
Network card
SIMATIC PCS 7 ES/OS IPC847D IE Windows 7 CP 1623

Software licensing

The following section lists the software/license packages that you need for the
selected configuration.

Component Software/license packages
ES e SIMATIC PCS 7 AS/OS Engineering Software
(PO unlimited)
e SIMATIC PCS 7 AS Runtime License
OS Single Station Redundant e SIMATIC PCS 7 OS Software Single Station

Redundancy (Single License for 2 installations)

e 2 X SIMATIC PCS 7 OS Runtime License
(max. of 8,500 POs)
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5 ES, OS Master and OS Standby

5.3 Step-by-step configuration

5.3 Step-by-step configuration

Note The following instructions have been drawn up based on Windows 7 and
PCS 7 V9.0.

CP1623 are used as an example of the plant bus transition. Time
synchronization is activated.

The PC stations used in the test setup are called:

e ES: ESV81
e OS server: SVA
e OS server standby: SVB

5.3.1 Preparatory activities

Create a project folder on the OS master and the OS standby and share it. This
makes it possible to transfer the OS data that is configured on the engineering
station to the OS master and the OS standby.

5.3.2 ES configuration

Creating the multiproject

As the basis for the instructions below, all of the PC stations must be physically
networked as shown in the illustration in chapter 5.1. Apart from this, you must
create a multiproject on the ES in which the hardware and software of the AS are
already configured.

Then, you start with the following CPU and CP settings.

AS settings

The analyzability of the process data requires that all of the components of the
process control system work with an identical clock time to be able to assign
messages in the correct time sequence.

The following section describes a way in which the redundant OS Single Stations
specify the master time.

Note More time synchronization options are described in detail in the following
manuals:

e "SIMATIC PCS 7 Operator Station (V9.0)"
https://support.industry.siemens.com/cs/ww/en/view/109746516

e "SIMATIC Process Control System PCS 7 Time Synchronization (V9.0)"
https://support.industry.siemens.com/cs/ww/en/view/109746544
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5 ES, OS Master and OS Standby

5.3 Step-by-step configuration

In the "Clock" section, set "Synchronization
Type - As slave” for the AS.

Click on the "OK" button to confirm your
selection.

Step Activity Screenshot
1. Open the HW Config for the AS. [ HW Config - [AS1 (Configuration) — K2_HP_Pri) =IOl x|
Highlight the CPU d ch "Object Ol Staon Edit Insert PLC View Options Window Help =13 x|
| | e anda choose ec -
ghlight the ¢ ! D@8 R[S % dallo B
properties..." in the shortcut menu. -
PS 407 10A
[ cPu a105H
Copy Ctri+C
Faste (Chrl
IF1 L | lusert MultiControler Device
IF2
x5 |@ PwOx5 | Replace Object...
XEPIR Port 7 fAdd IMaster System
XEP2R Part 2 isconnest Master System
X8 PN-I0-X8 [Master System [sochronous Made!
XBPIR Port 1 Insert PROFINET IO System
XEP2R Port 2 Disconmect PROFINET 10 Systerm
3 HiF CP 443-1 PROFINET 10 Domain Management. ..
X1 FNAO PROFINET IC Topalogy e
XTPTR ot 1 PROFIMET IE Multi-Contraller Bevices. ..
":7 2 £t PRORINET I6) Tsacfraneus mede
= Specify Madule,, .
Delete Del
GoTo »
Filter Assigned Modules
Maritar/Modify
. Alt+Return lJ
. @pen Chject With, ., AT
————— | Changefccess rE
:I:I 0] UR2aLU Assign Asset ID...
Slot Module Product Support Information Ctrl+F2
T FS 407 108 s T
Find Manual Ctrl+Fe
9 CPU 410-5H | S e Fom »
T Stark Device Taol
Displays proper ties of the selected object for editng. i
2. Switch to the "Diagnostics/Clock” tab. Properiics = CRUATHSHEIERES, x|

" General | Statup | Cycle/Clock Memory | Retertive Memory | Memory | intemupts |

Time-of-Day Intemupts | Cycic Intemupts ~ Diagnostics/Clock | Protection | H Parameters
— System Di
7| Extended functions
¥ Report cause of STOF!
I™ Acknowledgment triggered reporting of SFE33-35
Number of messages in the diagnostics buffer [3200
~Clock
Synchronization Synchrenization Type Time Interval
Inthe PLC: [Asslave = [Nene =
O th WF: [Mone =] [none =
O e biE] [None =] [Nene =l
Comection factor o ms
Cancel Keb
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5 ES, OS Master and OS Standby

5.3 Step-by-step configuration

Step

Activity

3.

Open the shortcut menu of the CP and
select "Object properties...".

Screenshot

[ HW Config - [AS1 (Configuration) - K2_MP_Prj] =1o]xI
Eﬂ]slzﬁon Edit Insert PLC View Options Window Help _|55|
D2 &g ae aa BHE 8 e
o

1 PS 407 10A B

3 CPU 4105H

xi FEE

IF1

IF2

Copy cirl+C
Paste Chrl
Insert Mulki-Cantroller Device

El Replace Object...
| AddiMaster System
Disconneck [Master System
Master System Tsochronous Mods
Insert PROEINET 10 System
Dijsconnect PROFINET IO Systen
FROFINET I Domain Management. . .
PROFINET I Tapalogy v«
PROEINET I3 Multi-Contraller Devices, ..
PROFINET I8 Isochranous mode

Speciy Module, .

5

|
4| @ URzsLU

Delete Del

GoTo r

Slot Module  Filter Assigned Modules
1 PS 407 10

Maritor/Madify

3 CPU 410

Displays properties of the sele Change fizcess >

Switch to the "Time synchronization" tab.
Select the "Accept time of day on CP and
forward" check box.

Click on the "OK" button to confirm the
setting.

JQ
— Obje . Alt+Return |
Open Objeck With:.. Chr{+A{-+0
£
x|

Properties - CP 443-1 - (R0/S5)

SNMP | Web | Diagnostics
Genersl | Addresses | Options  TimeofDay Synchronization | IP Access Protection
(- SIMATIC Mod

™ Accept time of day on CP
......................................... ™ Use corected time

& Automatic " From station " From LAN
~NTP Mod

= Activate TP time-of-day syrichranization

I=| Time-of-day synchionization or the ful minute

™| Accept time of day from non-sprchinized TR servers

¥ | Forward time of day bo station

NIF server addresses (IF sddiesses):

Ldd,

Edi.
Delete

Tirie 2gne: J{GMT +01.00) Belin. Bem, Bussels, Rome, Siockhol, Vienna =

Update interval [secands) 0
[Rienge of values 160 - BE400]

G|t

Save the configuration and compile it
using:

"Station > Save and Compile...".
Close the HW Config.
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5 ES, OS Master and OS Standby

5.3 Step-by-step configuration

Setting up the ES PC station
A PC station is created for the ES using the WinCC application to allow testing of

© Siemens AG 2018 All rights reserved

the OS project on the ES.

Step

Activity

Screenshot

In component view, open the shortcut
menu of the project and use "Insert New

[7] SIMATIC Manager - [K3_MP_MP (Component view) - D:\Minini o [=] 53
(%] File Edit Insert PLC View Options Window Help == x|

S EEEEE AT EETEE

| < No Fiter >

Object > SIMATIC PC station" to add a 251

new PC station. Open object Calesks0
Cut Gl
Copy: (arfie
Paste. b4
Delete Del

[}  smaTIC 400 Station
»  SIMATIC 300 Station

PLC »  SIMATIC H Station
3

SIMATIC PC Station

Access Protection e
PCS 7 License Information... SIMATIC 55
PG/PC
Shared Declarations v
Plant Hierarch N
g PROFIBUS
SIMATIC BATCH 13 Industrial Ethernet
PP
Rename 2 Foundation Fieldbus
Object Properties. .. Alt+Return
S7Program

Preconfigured Station. ..

05
05 (Client)

Shared Dedarations

Batch process cel

Inserts SIMATIC PC Station at the curser position. Praject Documentation

Use the shortcut menu to open the object
properties of the PC station.

-loix]

File Edt Insert PLC View Optons Window Help

O 8% 4 B e |d o 2] 2

@ K1_MP_Lib N iy Open Object Crl+AIt+0

cut ctrl+x

Copy ctrl+c

Paste Gl

Delete Del

PLC 4
Access Protection »
Print »
Rename

... Alt+Return

Displays properties of the selected object for editing. 4
3. Change the name of the ES PC station to B
match the name of the local computer on General | Satings | Corfurtn |
the network. Name [Esvet
Select the “Computer name identical to PC Fsenal LTSI SR =
station name” checkbox. Storage ocation KI_WF_Pr E
of the project: =
Author: I
Date created 10/12/2017 02:25:19 FM
Last medified 10/12/2017 02:25:19 PM
Comment: =]
=
Comptter nam
[V Computer name identical to PC station name
Computer name: ESVBT
Cancel Help
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5 ES, OS Master and OS Standby

5.3 Step-by-step configuration

Step Activity Screenshot
4. Open the HW Config of the ES PC station Smmc Manager - [K3_MP_MP (Component vie ﬂil
Vla the ShOI"[CU'[ menu. B»| File Edit Insert PLC View Options Window Help |7 x
D 8| e |dno %% = &1 |[< Mo Fiter
=-[=a] K3_MP_MP B wation
=8P K3 MP_P Cirl-+Alt+0
£51
r@. ESve Gt CErl
B-{1] Shared Declarations ooy ik
-8 K3_MP_Lib Faste. CErlHy
Delete g
Access Protection »
SIMATIC BATCH 3
Rename F2
Opens selected object. v
5. Insert a "WinCC application” and a network
card of type "CP1623” ] q WinCC Appl.
from the object catalog (View > Catalog). 2 CP 1623
3
4
5 -
&
7
8
2)
10
11
12 d|
6. Under “Subnet”, choose the plant bus or ]
create it by clicking on the “New..." button. Generd  Parametes |
Assign the corresponding MAC address to Fo e e e
the CP1623. HAG e
Deselect the "IP protocol is being used” L
IP address: [1s2.168.0. = Do ot tse 1outer
CheCkbOX . Subnet mask 255.255.255.0 oL ' :
Click on the “OK” button to confirm your O L outey
settings. o s
[ — not networked — New...
Properties
Delete
Cancel Help
PCS 7 Minimal Configurations
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5 ES, OS Master and OS Standby

5.3 Step-by-step configuration

Step Activity Screenshot
7. Open the shortcut menu of the CP1623 “{OPC
and select "Object properties...".
3 Copy Ctrl+C
4 Paste Chrli
5
6 Replace Cbject...
7 Add Master System
8 | Disconnect Master System
8 || Master System Isachranaus Made
10 || Insert PROFINET IS System
i || Disconneck BROFINET I System
12 PROFINET: [0 Domain Management, .
BROFINET IO Tapalagy..
FROFINET [0/ Isochronous mode
Specity Madule, ..
Delete el
Go To 3
Filter Assigned Modules
Ianitar/Madify
Edit: Symbals, .,
Object Properties... Alt-+HReturn
Gpen Ohject With, ., Chrl A+
Change Access 3
8. Switch to the “Options" tab and select the [
"Time of day” checkbox. Gonera | Asigrment Cptns | Diagrosis |
Click on the "OK" button to confirm your it e
selection. il (s
@ Slave fime receiver)
Send Keepalives for Connection:
(IV Activate (30 seconds) ‘
Settings for TCP prot
’7NDIS IP gddress ‘
Cancel Help
9. Save and compile using menu command:
"Station > Save and Compile...".
Close the HW Config.
10. Delete the OS of the Engineering Station in
Optionally | SIMATIC Manager as it is not needed in
our example.
PCS 7 Minimal Configurations
Entry ID: 24023824, V7.1, 02/2018 61




© Siemens AG 2018 All rights reserved

5 ES, OS Master and OS Standby

5.3 Step-by-step configuration

Setting up the Master OS PC station

Step Activity Screenshot
1. In component view, open the shortcut ~lofx|
. " (@] File Edit Insert PLC View Optons Window Help == %]
menu of the project and use "Insert New D@|2e] b ek %
Object > SIMATIC PC station" to add a a@g,w i 251
- [ 3 *_ P
new PC station. F eyl Criero
Gt Gl
Copy. Chl+C
Paste G+
Delete Del

Insert New Objec SIMATIC 400 Station
Multiproject > SIMATIC 300 Station

pLC »  SIMATIC H Station
Access Protection D e
PCS 7 License Information... SIMATIC 55

PG/PC
Shared Dedarations 3

MPL
Plant Hierarchy [
SIMATIC BATCH ¢ Industrial Ethernet
3 = Foundation Fieldbus
Object Properties. .. Alt+Return

S7Program
Preconfigured Station. ..

0s
05 (Client)

shared Dedarations

Batch process cell

Inserts SIMATIC PC Station at the cursor position. HEERII s T 4
2. Use the shortcut menu to open the object MATIC Manager - [K1_MP (Component View) - d:\KL =lofx|
: : Fle Edit Insert PLC View Options Window Help =13 x|
roperties of the PC station.
prop O (82 4 &2 dnlo %5 %[ [ < Vo Fiter >
=){=al K1_MP Canfiguration
=8P KI_MP_Pr
i 451
Open Object Ctrl+alt+0
Cut Ctrl+x
Copy Ctrl+C
Paste. Gy
Delete Del
PLC 3
Access Protection »
Print »
R F2
Displays properties of the selected object for editing. v
3. Change the name of the OS master PC £

station to match the name of the computer
on the network.

Select the “Computer name identical to PC
station name” checkbox.

General |Semr|gs| Canﬁgurationl

Name: [sva
Project path: ‘KT_MF_PU\S\MATIC PC Station(1) ﬂ
Storage location AKT_MP_Pr -
of the project -
Author: |
Date created: 10/A17/2017 10:25:42 AM
Last modified. 10/17/2017 10:34:59 AM
Commert: =
Computer name
[ Computer name identical to PC station name
Computer name: SVA

— T
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5 ES, OS Master and OS Standby

5.3 Step-by-step configuration

create it by clicking on the “New..." button.
Assign the corresponding MAC address to
the CP1623.

Deselect the "IP protocol is being used”
checkbox.

Click on the “OK” button to confirm your
settings.

General  Parameters |
¥ Set MAL address / use IS0 protocol

MAC address

™ IP protocol is being used

Step Activity Screenshot
4. Open the HW Config of the OS master PC
station via the shortcut menu.
D |2 =edls =
=-[78) K3_MP_MP B iqu
2189 KI_MP_Pi Crl+Alt+0
A51
Gt Ghrl+
e Copy ChrlHE
-{_] Shared Declarations Haste Gabrl ey
e K3_MP_Lib [elets el
Access Protection 3
SIMATIC BATCH 3
Rename F2
Opens selected object, v
5. Insert a "WinCC application” and a network | EXVIES
card of type "CP1623” from the object A WintC Appl. a
catalog (View > Catalog). 3 CP 1623
3
4
5 .
6
7
8
9
10
1
12 hd|
6. Under “Subnet”, choose the plant bus or E

IP address: [1728102

Subnet mask: 255 2552550

Subnet:

Gateway

% [0 not use router

) Wse router

Address:

— ot networked — New
Properies...
Delete

Cancel Help
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5 ES, OS Master and OS Standby

5.3 Step-by-step configuration

Step

Activity

Screenshot

7.

Open the shortcut menu of the CP1623
and select "Object properties...".

Copy Ctrl+C
Paste Chr[

Replace Cbject...
Add Master System
[isconmeck Master System
8 IMaster Systemn Isochronous Mode
10 || Insert PROFINET IS System
i || Disconneck BROFINET I System
12 PROFINET: [0 Domain Management, .
T | ERGFINET IO Topalagy...
PROFIMET) IO Isachronous mode

Specity Madule, ..

Delete Del

Go To 3
Filter Assigned Modules

Ianitar/Madify

Edit: Symbals, .,

Object Properties... Alt-+HReturn
Gpen Ohject With, ., Chrl A+
Change Access 3

Switch to the “Options" tab and select the
"Time of day” checkbox.

Click on the "OK" button to confirm your
selection.

Properties - CP 1623 x|

General | Assignment  Options | Diagnostics |

Time-of-Day Syr

Ma

& Slave fime receiver)

[time sender]

Send Kespalives for Connection
(l? Aefivate (30 seconds] ‘

".Semngs for TCP prot

NDIS IP gddress ‘

Cancel Help

Save and compile using menu command:
"Station > Save and Compile...".

Close the HW Config.
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5 ES, OS Master and OS Standby

5.3 Step-by-step configuration

Setting up the OS standby PC station

Step Activity Screenshot
1. In component view, open the shortcut CEETTRECTE -0
; i Edt nsert PLC Vew Optons Wndow fic N
menu of the project and use "Insert New D@ 207 5 e [o 5 o o> E
Object > SIMATIC PC station" to add a E
new PC station. Open St e
(Ut s
Copy e
Paste CEr 4
Deletz 2]

jec [ smaTIC 200 Station
Multiproject »  SIMATIC 300 Station
PLC » SIMATIC H Station
o SIMA” PC Statior
Other Station

Access Protection

PCS 7 License Information... SIMATIC 55
PGPC
Shared Dedarations »
I m , ™
Plant Hierarchy eI
SIMATIC BATCH »  Industrial Ethernet
PP
(s = Foundation Fieldbus
Object Properties... Alt+Retun
S7Program
Preconfigured Staion...
os
05 (Client)
Shared Dedarations
Batch process cell
Inserts SIMATIC PC Station at the cursor position. Project Documentation 4

2. Use the shortcut menu to open the object
properties of the PC station.

[ SIMATIC Manager - [K1_MP (Component View) — d:\KL - o) x|

(3] File Edit Insert PLC View Options Window Help &%
D222 =R d|e %= & [[<NoFter> |
Configuration
Y=} Open Object Ctrl+Alt+0
=@ K1MP_Lib cut Ciri4X
Copy cirl+C
Paste Chrl
Delete Del
PLC 3
Access Protection »
Print 13
Rename F2
[t+Return

Displays properties of the selected object for editing. A

3. Change the name of the OS standby PC
station to match the name of the computer
on the network.

Select the “Computer name identical to PC
station name” checkbox.

Properties - SIMATIC PC Station ll

General |Semr|gs| Canﬁgurationl

Name [sve
Project path: ‘KT_MF_FU\S\MATIC PC Station(1) ﬂ
Storage location NK1_MP_Pr -
of the project -
Author: I
Date created: 10/17/2017 10:36:54 AM
Last modified. 101772017 10:36:54 AM
Commert: =]
Computer name
[¥ Computer name identical to PC station name
Computer name: SVB

— T
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5 ES, OS Master and OS Standby

5.3 Step-by-step configuration

Step Activity Screenshot
4. Open the HW Config of the OS standby =10l x|
PC station via the shortcut menu. 2] File Edltnlnsert PLC Wiew Options Window Heli _ =& x|
sAEEEERTI BT (5 [« No Fiter
=T 3l K3_MP_MP = ot ]
@ % K3_MP_Prj Open Object Ctrl+Alt+0
. B cue Chrit
Copy. Chrl+C
Paste Ehrl
{7 Shared Declarations Delete el
-6 K3_MP_Lib
Access Protection 3
SIMATIC BATCH 3
Rename F2
Opens selected object. v
5. From the object catalog (View > Catalog), E (0) PC
insert a "WinCC application (Stby)" and a q WnCC Aol (Sthy ) -
network card of type "CP1623". 3 CP e
3
4
5 -
3
7
8
9
10
11
12 =l
6. Under “Subnet”, choose the plant bus or =
create it by clicking on the “New..." button. Geners Pormeers |
Assign the corresponding MAC address to o
the CP1623.
Deselect the "IP protocol is being used” -
checkbox. P & Do ratuse
ubnet ma
Click on the “OK” button to confirm your @ Usrage
settings. ” e
ubnet
— not networked — New..
Properties
Delete
Cancel Help
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5.3 Step-by-step configuration

Step

Activity

Screenshot

7.

Open the shortcut menu of the CP1623
and select "Object properties...".

Copy Ctrl+C
Paste Chr[

Replace Cbject...
Add Master System
[isconmeck Master System
8 IMaster Systemn Isochronous Mode
10 || Insert PROFINET IS System
i || Disconneck BROFINET I System
12 PROFINET: [0 Domain Management, .
T | ERGFINET IO Topalagy...
PROFIMET) IO Isachronous mode

Specity Madule, ..

Delete Del

Go To 3
Filter Assigned Modules

Ianitar/Madify

Edit: Symbals, .,

Object Properties... Alt-+HReturn
Gpen Ohject With, ., Chrl A+
Change Access 3

Switch to the “Options" tab and select the
"Time of day” checkbox.

Click on the "OK" button to confirm the
setting.

Properties - CP 1623 x|

General | Assignment  Options | Diagnostics |

Time-of-Day Syr

Ma

& Slave fime receiver)

[time sender]

Send Kespalives for Connection
(l? Aefivate (30 seconds] ‘

".Semngs for TCP prot

NDIS IP gddress ‘

Cancel Help

Save and compile using menu command:
"Station > Save and Compile...".

Close the HW Config.
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5.3 Step-by-step configuration

Configuring all of the PC stations

The "Configure PC station" function transfers project configurations to one or more
target stations. First, configure the local ES and then all of the operator stations

that are connected to the plant bus.

Step Activity Screenshot
1. Configure the Station Configuration Editor Aﬂ'ﬂ|
. R e Edit Inserf iew Options Window Help
of the ES. To do this, select the PC station D@8 b B s %% =% %
Of the ES and |n the ShOI‘tCut menu (% K3_MP_MP (Component view) -- D:\Mininimal\Projects\K3\K3_MP_} ol x|
=} K3 MP_MP Configuration
. K3 _MP_Pij i
lclzhoose. _ ) 5 &g:%‘. i
PLC > Configure...". BB g criao
é‘l :::m cut ctri+x
o @ Rawrli T2 g
Delete Del
Access Protection »
B3 ' Compare...
SIMATIC BATCH 13
Rename F2
Object Properties... Alt+Return
Configures a selectable target computer according to the structure or the selected PC station (initial freconfiguration) A
2. Under "Accessible computers:” choose the x|

PC that you want to configure.

NOTE

If you chose the option "PC name identical
to PC station name" for the PC station in
the “Object properties”, the system
displays directly in the component
configurator the target PC to be
configured.

Using the “Display..." button, you can show
the current configuration of the PC station.

Click on the “Configure...” button.

Local netwark, connection:
I Terminal bus j

Wpdate |

Accessible computers:

ESWE1
SWA
SWE

v Usze configured computer name

Target computer:

|Esva1

Dizplay... |

Meszagesn

LCloge | Help |
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5.3 Step-by-step configuration

information dialog.

Step Activity Screenshot
3. In the window that appears, you can see x|
how the PC station is configured. Statian: (EE
Click on the "OK" button to confirm this ‘ndilél;ma | Tope [ status | Cause =
H 1 WinCC Appl. WinCC Appl.
setting. 2 I crigzs CP 1623
3
4
5 | |
3
7
A
]
10
1
12
13 =
4| | _'lJ
@ The configuration is possible. The configuration can be seen in the list
abaove.
Cancel | Help |
4. Click on the "OK" button to confirm the finformabon X

If the component configuration is changed, the entire PC station
' % wil be reconfigured and the existing database is lost.
~ This can take several minutes.
Make sure that no communication or diagnostics is active over a
component in the current configuration.

cos|

message:
"Transfer completed successfully."

Close the configuration dialog.

5. In the bottom window, you then see the

x|

Local nebworks connection:

I Terminal bus j

Wpdate |

Accessible computers:

ESET
SWA
SWE

v sge configured computer namme

Target computer;

|Esve1

Dizplay... |

Messages:

Configuration runmning.

ESWET:

Transfer completed successfully.
Configuration completed.

LClose | Help |
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5.3 Step-by-step configuration

Step

Activity

Screenshot

6.

Configure the Station Configuration Editors
of the OS master/standby as shown in
steps 1to 5.

Configuring and loading AS-OS communication

In the following section, the connections between the PC stations and the AS are
configured in NetPro and loaded in the individual stations.

Note In the case of a granular station configuration, you must merge the subnets of
the individual sub-projects first.
Step Activity Screenshot
1 Open NetPro. e SE]
Highlight the WinCC application of the ES S %S R T8 Bl (N : i
and open the shortcut menu. Choose
"Insert New Connection". u T
mm | m
2
PlantBus
Industrial Ethernet
Highlight »
Download to current project 3
Rearrange
Object Properties Alt+Return
4 . o
| Inserts a new connection in the connection table. [PCinternal.local.
2. In the "Connection Partner” window, select | [imaa mpee e x|

the CPU of the AS.

Make sure that an “S7 connection" is
selected under “Connection”.

In this example, a high-availability S7
connection is configured due to the AS
configuration.

Click on the "OK" button to confirm your
selection.

— Connection Partner

EI@ I the curent project
=& KI_MP_Py
=

- &l broadeast stations

- Al multicast stations
[]--@ I the mulkiproject: K.3_MP_P
@ I unknown project

. T_<
Project: |K3_MP_Frj £
Statioh: |A5‘|
Module: |CPU 410-5H

i~ Connection
Type: I 57 connection i

¥ Display properties before inserting

ak. I Apply Cancel | Help |
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steps 1to 3.

When doing this, it is important that the
connections of the OS master, OS standby
and of the ES to the AS have the same
name.

After this, use the

""Network > Save and Compile..." menu
item to save the configurations and
compile them.

Select the "Compile and check everything"
option button and click on the "OK" button
to confirm your selection.

Step Activity Screenshot
3. On the “General" tab under "Connection 5
identification”, change the s el _
“Local ID:" to a descriptive name like AS1, [ e P e P
for example_ I Cofigured t one end 5]
H “ ” . I¥ | Establish an active connestion VFD Name:
Click on the “OK” button to confirm your TR [WirCC A
settings.
1~ Connection Path
Logal Partner
s s\fswr‘(ﬂaé/ﬂpp\ |§L’4105H
Interface: [cP 1623 x| [cpaa31.Pi-ORL/SE) =
Subnet [PtantBus [indusiral Ethemet] [PlantBus [industrial Ethemet]
Address [oo-18-16-90-1364 Jos-00-06-01-00-03
Address Details.
= Hep
4, In the connection table of the AS, change [ NetPro - [K5_Prj (fietwe 1ol x|
Optionally the |0ca| ID for the Connection to the ES tO %Q Metwork  Edit Insert PLC View ©Options ‘Window Help - ﬂlﬂ
= [d 1 tr e 5 1 wd
a value of greater than 0xc00. AR AT Il L
Plantbus =
Note Industrial Ethernet
A connection ID of greater than 0xc00 T
prevents the AS from generating
messages in later operation due to starting 5 I
or stopping of OS simulation on the ES. depl [1222 i
=]
lsva | sve |
=l [wincc[cr [l [Wwince JoF
e |Apel |[1222 e |Aepl [1222
(Stby
=] =] hd
I — _'lJ
Local ID Partner ID  |Partner 3
2 AS1 SWA /' WinCC Appl.
3 AS1 SWB / WinCC Appl. (Stby.)
Appl
JReady A
5. Also set the connections of the OS master save and Compile x|
and OS standby to the AS by repeating
[~ Compile

¢ Compile and check everything
" Compile changes only

0K I Cancel Help
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5.3 Step-by-step configuration

Current Project > Selected Stations" menu
item to download the connection.

Download the AS, the OS master, and OS
standby in the same way.

Then, close NetPro.

AS1
CFU_1DP [PN- [PN- [OF [PNID
AI0EH L 11005 100 (4431,
Ho |
2

:

PlantBus
Industrial Ethernet

Step Activity Screenshot
6. Highlight the ES and download the etero - 3PP (Network) - De\inmmall G CHME =0l
. « 98 Network Edit Insert PLC View Options Window Help =181 x|
connection use the “PLC > Download to ZHE & B da b 00 Dl W
|

I

Open Object Ctrl+alt+0
g - Copy crrl+c
(stoy.
Delete Del

Rearrange

Object Properties. ..

q
| |

| Downloads the selected stations (HW data, connection data, gateway data).

[PCinternz
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5.3 Step-by-step configuration

Master/Standby settings on the ES

Here, you define the master/standby assignment and set the loading paths.

Step Activity Screenshot
1. In SIMATIC Manager, open the properties £
dialog of the OS master PC station. Genera Target OS and Siandby 05 Camputer |
Switch to the "Target OS and Standby OS Pathto the Target OS Computer
Computer" tab. [ Search ..
Select the Standby OS from the drop-down Symbolic compuer name
|iSt. IOS_Master
Select the "Create/update archive tags" s
checkbox [0S _Master_stey =l
) ) [V Create/update archive tags
Clear the “Transfer to external archive I Transfer to extemal archive senver
Server" Checkbox |f you are not u3|ng a If target O5 computer is identical to ES computer:
Process Historian. e e
Click on the "Browse" button.
2. Use the drop-down list to navigate to the
shared project folder of the Master OS
(see 5.3.1 Preparatory activities).
Click on the "Save" button.
3. In the "Path to Target OS Computer” input kS
field, check again the whole project path. General Target 05 and Stancby 05 Computer |
Click on the “OK button” to confirm your Path to the Target 05 Computer
entry. [WSVA\Projects 05 _Master\0S_Master mcp Search
Symbolic computer name
IOS_Master
Standby OS
[05_Master_stBy = |
[¥ Create/update archive tags
[~ Transferto extemal archive server
I target 05 computeris identical to ES computer.
Assign archive server
Apply Cancel
4. Open the properties dialog of the Standby |
0OS PC station. General Target OS and Master 05 Cnmputersl
Switch to the Path to the Target OS Computer
"Target OS and Mater OS Computers" tab. fl Search .
Check whether OS_Master is entered in
the "Master OS" field too.
Click on the "Search..." button to select the a0
storage path of the OS data. 05 Maser
Note:
In the properties of the master OS, the path to the targst 05
computer must be specified as well
Aprly Cancel
PCS 7 Minimal Configurations
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5.3 Step-by-step configuration

Step Activity Screenshot
5. Use the drop-down list to navigate to the ’ ——— =T ;‘
shared project folder of the Standby OS A ——— ——— =
(see 5.3.1 Preparatory activities). savess oo [Crsy =
Click on the "Save" button. o |
6. In the input field, check the "Path to the x
Target OS Computer". (Genersl  Target OS and Master OS Computers |
Click on the "OK" button to confirm this. Path to the Target O Computer
Click on "Yes” to confirm the dialog that is WSVBProjects 03 _Master\0S,_Master mcp _ Seh. |
displayed next.
Master OS5
05_Master
Note:
Inthe properties of the master OS. the path to the target OS
computer must be speciied as wel
oy e |
Compiling and loading the user program
Compile the S7 program and download it to the AS.
Compiling the OS project
Compile the OS project of the Master OS in SIMATIC Manager.
Make sure that you make the correct OS assignment to the server in plant view.
PCS 7 Minimal Configurations
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5.3 Step-by-step configuration

533 OS configuration

Configuring the OS on the engineering station

On the ES, you switch from a multi-user system to a single-user one and make the
settings for redundancy and time synchronization.

Step Activity Screenshot

Master OS. = WinCC Explorer - D= - 10| x|

In the open WinCC Explorer, highlight the J File Edit Wew Tools Help

OS project and choose “Properties” in the R
shortcut menu. J | 1l _/| J » | {- Eﬂ _E|| J_‘I

----- 1 Tag Management

----- I.F'!\ Graphics Designer

----- ;4]' Alarm Logging

----- J_|_| Tag Logging

ﬁ Report Designer

----- J :E Global Script

Text Library

----- 5 Text Distributor

----- i}i' User Administrator
----- R " Cross-Reference

----- @ Redundancy

----- J_|_| User Archive

----- '—:',I Time synchronization
—i] i Horn

----- l';E_'- Picture Tree Manager
L] Lifebeat Monitoring
-, OS5 Project Editor

----- _| _| Component List Editor

g SFC

----- " Web Navigator

05_Mastery o
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Step Activity Screenshot
2 On the “General” tab under “Type:’, |
choose "Single-user project". Operating Mode | User Interface and Design |
Confirm your input and the displayed Genewl | UpdateCrcles | Shotows | Optons
message by clicking on the "OK" button. Frer drmeiiE e T
Note: e Single-User Project] j
You need server packages for the function Crestor: [WinCC-Project-Manager
of the MS clients, i.e. the OS/MS server Creation date:  [12/16/2012 £16:41 FII
must not be a ;ingle-user projgct. If the Changedby:  [VinCC Projoct Manager
OS/MS server is set up as a single-user achange: [T/ TN
project, the MS client cannot be used on oo |
the ES. o
GUID: CC_OS5_5 14 12_16_16_16_40
Comment: d
=l
0K | Cancel |
x|
L. A change from a multi-user to a single-user or WinCC dient project
L will delete all configured dient computers from the computer list.
= Clickon <OK> to perform this change,
or on <CAMCEL > to keep the multi-user project.
o_|
3. Click on the "No" button to prevent the Change project type ]
startup list from being deleted.
|"/ _-'\'-I The praject type was changed.
' Do you want to delete the startup list?
Yes
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Step Activity Screenshot
4. Open the "Redundancy” editor. |
General | User Archive |
Select the "Default Master" checkbox.
Enter the Standby OS in the "Redundant e
partner server" field. [ Browes
Check whether you have selected the Local Computer Seting:
desired checkboxes under "Optional Cennectio o redundant patner via network adapler
Settings". Pone =
In the drOp-dOWn |iSt, SeleCt the Connection Connection to redundant partner via serial interface {optional) CoM1 -
path that is used to connect the Master OS
and the Standby OS " Synchronize all data of the outage period.
A “ » . & ronize faiures of last |2 onl
Click on the “OK” button to confirm your e e
settings. ~Optional Setting:
¥ Synchronization of Tag Logging after the partner server comes back online
[V Synchrenization of Alamm Logging after the partner server comes back online
¥ Orline synchronization for Alarm Logging
[¥ Synchronization after disnuption of the pracess link (Tag Logging + Alam Logging)
[¥ WinCC client switch in case of a process connection emor
Enables the synchronization for all specified options and user archives:
¥ Activate Redundancy
oK | cancel | Hep |
5. Open the "Time Synchronization" editor. 2]
 General Settings
- . . o oK.
Select the "Synchronization via System I Use time receive utity \—I
Bus (MaSter, SlaVe)" checkbox. ™ Deactivate time synchronization Cancel |
Under "Access point 17, choose I Syrchronzston o Temind Bus leve]
"CP1623 ISO " and SeleCt the "MaSter" C ronization via Terminal Bus 3Ve
radiO but’[(0n ) =) Wse the tme from a connected WinCE senver
Clle on the “OK,, button to confirm yOUr 7 se the time from a specific computer:
settings. E =
Earmputer 2 I J
NOTE = LLet time be set by external [3rd - party] components
If yOU COr-lﬁgl:Ire Station' tlme —I¥ Synchranization via System Bus [Master, Slave]
synchronlzatlo_n on a different compu_ter, ~ tooess point 1
the access points are not known, which [<Crieeoi =] & Master
means that they are not available in the © Slave
drop-down list. To choose the access point
regardless, select the "Display symbolic e P
name of the access point" checkbox and <Mane> [ P
then choose the appropriate access point.
[+ Display spmbolic name of the access point
i~ Process controling messages Project documentation—
¥ Sendonce Print I
Send every I _Ij mihutes ﬂl
Setup I
6. Close the OS project.
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Downloading the OS project to the OS computer

Once redundancy and time synchronization have been configured on the ES,
download the OS project to the Master OS and the Standby OS.

download is required.

Click on the "OK" button to start
downloading.

Step Activity Screenshot
1. In SIMATIC Manager, highlight the Master =lolx|
OS and choose “PLC -> Download" in the D@ 8% % B e 6o % % hores
shortcut menu. £ K3_MP_MP (Component view) — D:\Mininimal\Projects! ol
=) [=8] K3_MP_MP P RMT1
-89 K3_MP_Pri - RMT2
. mE e
| & Esval
=3, Sva
B[ win
L.
=&, SvB Cirl+Alt+0
- wint
& g Cut Cirl+x
{3 Shared Dy Copy cirl+c
& K3 MP_Lib Paste kel
Delete Del
Insert New Object
PLC
Access Protection
Compile Ctrl+B
Display compilation log...
Display load log...
Generate server data
Assign 05 server...
Start OS simulation
Import WinCC ohjects
Print 3
Plant Hierarchy >
SIMATIC BATCH 3
Rename F2
< Object Properties. .. Alt+Return
Downloads current object to the PLC. A
2. For the first OS project download, an entire X

Target syster: \\SVA\Projects\05_Master\OS_Master. mcp

- Scope
% The entire WinCC project
! Changes Dretails

™ Start compilation before downloading

The entire WinCC project will be transferred ta the rntime 05,

0K I Cancel Help
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Step Activity Screenshot
3. After successful downloading, the OS
project is located in the specified folder on
the MaSter OS Download to target system was completed successfully.
Click on the "OK" button to confirm the
message that is issued.
Eror |
£ none x
ak I Cance
4
4. Repeat steps 1 to 3 to download the OS
project to the Standby OS.
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Configuring on the operator station

Generally, we would advise you to check the project settings after the project has

been downloaded to the target systems.

Note Normally, all configuration work is carried out on the ES to ensure consistent

data management. This means that no WinCC engineering licenses are needed
on the OSes. However, each time WinCC Explorer is opened, a license-free time
window of two hours is available for WinCC configuration work.

"Server" field.

"Redundant partner server:".

Settings".

Standby OS is set.

settings.

Check the name of the Master OS in the
Select the "Default Master" checkbox.
Also, check whether the name of the
Standby OS is entered correctly under

Check whether you have selected the
desired checkboxes under "Optional

Check whether the connection path that is
used to connect the Master OS and the

Click on the “OK” button to confirm your

General | User Archive |

Server:

[sva

[ Default Master

Redundant partner server:

|5va Browse.

Local Computer Setting
Connection to redundant partner via network adapler.
None =

Connection to redundart partner via serial interface (optional): COM1 -

' Synchranize all data of the ovtage period,

& Synchronize faiures of last |2 days only.

Optional Setting

¥ Synchrenization of Tag Logging after the partner server comes back online

[¥ Synchronization of Alamn Logging fter the partner server comes back onine

¥ Online synchronization for Alam Logging

[¥ Synchronization after disruption of the process link (Tag Logging + Alam Logging)
¥ WinCC dlient switch in case of a process connection emor

Enables the synchronization for all specfied options and user archives:
[V Activate Redundancy

Step Activity Screenshot
1. Open the OS project on the OS project.
2. Open the "Redundancy" editor. =

OK I Cancel

Help
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Step Activity Screenshot
3. Open the "Time Synchronization" editor. @ Time Synchronization - [05_Master.mcp] Z[x]
i~ General Settings
L . ) o oK.
Check or select the "Synchronization via I Use tine receive uiiy \—I
System Bus (Master, SlaVe)" checkbox. ™ Deactivate time synchranization Cancel |
Under "Access point 17, check or select -
"CP1623(|SO)" and the "Master" radio 1 Synchionization via Terminal Buz (Slave]
button = sz the tine ffom & canmested WinEE semer
’ = sz the tine fiom aspeciic computen:

. « » . Camputen
Click on the “OK” button to confirm your ! -
settings. Eanstier % | [

= (et time be setbylexternall(Brd - party] camponents
—¥ Synchronization via Spstem Bus [Master, Slave)
~ Access paoint 1
[<crigzaismy (1) =l 0 besten
" Slave
[ Access point
o = = st
) Slave
¥ Display symbolic name of the access point
r~ Process controlling meszages Project documentation —
¥ Send once Print I
Send even I _lj mihutes ﬂl
Setup I
4. If you have made project changes in
WinCC Explorer, close the OS project and
open it again for the settings to take effect.
5. Repeat steps 1 to 4 on the Standby OS E
with the following modifications for step 2 = ]
Server:
(redundancy): e
e  The "Default Master" checkbox must ™ Defaul Master
Redundart partner server:
be cleared. o —
e  Check whether the name of the e Corputr S
Master OS is entered correctly under P W S .
"Redundant partner server:" and None |
change it if necessary. o s i S S e ) [comr =]
" Synchronize all data of the outage period.
% Synchronize failures of last |2 days only.
Optional Setting:
¥ Synchronization of Tag Logging after the partner server comes back online
[V Synchrenization of Alamm Logging after the partner server comes back online
¥ Orline synchronization for Alarm Logging
[¥ Synchronization after disnuption of the pracess link (Tag Logging + Alam Logging)
[¥ WinCC client switch in case of a process connection emor
Enables the synchronization for all specified options and user archives:
¥ Activate Redundancy
oK Cancel
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5.3 Step-by-step configuration
5.34 Activating runtime

First activate the OS project on the Master OS and then on the Standby OS. Before
activating the second runtime, it is advisable to wait until the boot process of the first
one has completed.

Online synchronization is active immediately.
By contrast, mutual synchronization of archives starts 10 minutes later.
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6 ES/OS Master and OS Standby

6.1 Configuration description

In this configuration with two redundant OS Single Stations, one of the stations is
used at the same time as an ES, which obviates the need for a separate third
station.

In this connection, you must pay attention to the following two criteria. This is why
we generally recommend creating a configuration with a separate ES
(see chapter 5 "ES, OS Master and OS Standby"):

Comparatively low savings potential

The savings potential has been reduced since PCS 7 V8.0 because the OS
runtime license is no longer included with the ES license. This means that, savings
are limited to one computer (hardware and Windows license).

Special considerations when configuring

The configuration differs from that of the PCS 7 Engineering Standard and
represents a kind of workaround.

You cannot use the "WinCC Application" and "WinCC Standby Application” PCS 7
standard tools, since it is not possible to download changes during operation. The
mechanisms controlling the fact that both systems must be in runtime and that
runtime on the ES must be stopped for the download to proceed block one
another.

For this reason, we configure only one OS application, open it on both stations,
and configure mutual redundancy locally in WinCC in each case. To be able to
download to the OS Single Station, runtime on the ES and the OS must be closed
first.

CAUTION  This configuration has been tested with a PCS 7 basic installation including the
Web Option. No statement can be made regarding the functionality with
additional optional packages.

Note The jump keys in the asset faceplates for hardware configuration and for PDM
function as follows:

- Upto PDM V8.1: On ES only
- PDM V8.2 and higher: On ES and Standby OS
- PDM V9.0 and higher: On ES and OS clients, and web clients
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Hardware configuration

Terminal bus

ES/OS Master

Redundancy

0S Standby

COM-Cable

Plant bus

EE
o] El

AS

1o

PCS 7 configuration

_ SIMATIC Manager - K4_MP_MP

File Edit Insert PLC View Options Window Help

=10 x|

D@ B 4 Bl B 5

|| < Ne Fit

=& ESVET

ﬂ oy

: |:| Shared Declarations
-8 K4_MP_Lib

=10l x|

-z K4_MP_tP
=8P K4_MP_Pi
- {7 Shared Declarations
El Flant
- [E) RAMT1
: &+-[Ea] AMT2
- K4_MP_Lib

£® K4_MP_MP (Plant View) -- D:\Mininimal

=10l x|

[B1l RMT1
(B RMT2

Press F1 to get Help.
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Limitations/Particularities

Due to the untypical configuration of PCS 7 with only one OS, there are differences
in system behavior that must be observed:

CAUTION

The first activated OS takes on the master role.

For an entire download to be performed, runtime must be deactivated and the
OS project closed on both computers. During this time, operator actions and
archiving are not possible.

To download changes, runtime must be stopped on the ES when compiling the
OS. These can then be re-activated to test the modified OS functions. For the
downloading process, runtime must be terminated and the OS Project must be
closed. As a result, it is not possible to take operator actions on the ES
computer during this time.

Depending on the changes that are carried out, if runtime remains active during
OS compilation, subsequent downloading of changes may not be performed
completely and will cause errors. If this happens, only an entire download is
possible.

When runtime is active on the ES computer, the runtime archives are stored in
the multiproject path. At archiving, they are included in the ZIP file, which causes
an increased demand on memory resources as well as longer archiving times
Workaround:

- Deactivate runtime on the ES computer

- Reset the archives in the OS project on the ES computer and close the
entire PCS 7 project

After archiving and re-activating runtime, the archives are synchronized again.
However, it must be noted that more time is needed for synchronization.
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6.2 Required hardware and software licensing

Hardware

For this configuration, we recommend using the hardware below which you can order via
the Siemens mall. This ensures that the appropriate number of selected operating systems
and SIMATIC PCS 7 system software packages are pre-installed on the PC stations.

Station Product designation Operating Plant bus transition
system
1 x ES/OS SIMATIC PCS 7 ES/OS IPC847D BCE Windows 7 | RJ45
Network card
SIMATIC PCS 7 ES/OS IPC847D IE Windows 7 | CP 1623
1 x OS Single SIMATIC PCS 7 ES/OS IPC847D BCE Windows 7 | RJ45
Station Network card
SIMATIC PCS 7 ES/OS IPC847D IE Windows 7 | CP 1623

Software licensing

The following section lists the software/license packages that you need for the
selected configuration.

Component Software/license packages

ES e SIMATIC PCS 7 AS/OS Engineering Software
(Unlimited POs)

e SIMATIC PCS 7 AS Runtime License

OS Single Station Redundant e SIMATIC PCS 7 OS Software Single Station Redundancy
(Single License for 2 installations)

e 2 XxSIMATIC PCS 7 OS Runtime License
(max. of 2,000 POs)
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6.3

Note

6.3.1

6.3.2

Step-by-step configuration

The following instructions have been drawn up based on Windows 7 and PCS 7
V8.2.

CP1623 are used as an example of the plant bus transition. Time
synchronization is activated additionally.

The PC stations used in the test setup are called:
e ES/OS Master:ESV81
e OS Standby: SV

Preparatory activities
Create a project folder on the Standby OS PC station and share it. This makes it

possible to transfer the OS data that is configured on the engineering station to the
OS master and the OS standby.

ES configuration

Creating the multiproject

As the basis for the instructions below, all of the PC stations must be physically networked
as shown in the illustration in chapter 6.1. Apart from this, you must create a multiproject
on the ES in which the hardware and software of the AS are already configured.

Start with the following CPU and CP settings.

AS settings for time synchronization

Note

The analyzability of the process data requires that all of the components of the
process control system work with an identical clock time to be able to assign
messages in the correct time sequence

The following section describes a way in which the OS Single Station that is
activated first specifies the master time.

More time synchronization options are described in detail in the following
manuals:

e "SIMATIC PCS 7 Operator Station (V9.0)"
https://support.industry.siemens.com/cs/ww/en/view/109746516

e "SIMATIC Process Control System PCS 7 Time Synchronization (V9.0)"
https://support.industry.siemens.com/cs/ww/en/view/109746544
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In the "Clock" section, set "Synchronization
Type - As slave” for the AS.

Click on the "OK" button to confirm this
setting.

Step Activity Screenshot
1. Open the HW Config for the AS. IL3HW Config - [AS1 (Configuration) —K2_HP_Prj). -0l =
H' hl ht th CPU d h "Ob' t Olj station Edit Insert PLC View Options Window Help 18] x|
| | e and choose ec . e ;
ghlight the 4 ! e R T LR
properties..." in the =
shortcut menu. dLE
Copy Ctrl+C
Paste Chrl4,
IF1 L InsertMulti-Controller Device
IF2
X5 PNHIOXE Replace Object...
X5PIR Poit T Add Master, System
X5P2R Port 2 Disconnzck Master System
Xz PAHIO-XE Master System Isochronous Mads
X8PIR Port 1 Insert PROFINET IO System
X8P2R Poit 2 Disconnect PROFINET [ System
5 i CP 443-1 PROFIMET IO Damain Management.
X1 Lileel PROFINET IG Topology...
ﬁ ij’ﬁ iarf; PROFINET) IO Mulki-Contraller Devices, ..
2 = PROFINET 16 Isochransus mode
2 Specify Module,
Delete Del
GoTo 3
Filter Assigned Modules
Wanitor/Modify
Edlt: Sy
Object Pr Alt+Return |8 |
= Open Ohjest With..., Chrl A+
Change Access rE
:‘!I [0 UR2ALU Assign Asset ID...
St Module Product Support Information ctri+F2
i F5 407 108 S S
Find Manual ctrl+Fe
3 CPU 410-5H e e o 3
- Start: Device Tool
Displays propertics of the selected object for caiting. A
n- " H H " jes - u 3
2. Switch to the "Diagnostics/Clock" tab. Properties - CRUSTISEERES =

General | Statup | Cycle/Clock Memory | Retertive Memary | Memory | Intemupts |

Time-of-Day Intemupts | Cyclic Intemupts ~ Diagnostics/Clock | Frotection | H Parameters
- System Di
I” | Extended functions.
7' Repot cause of STOP!
I~ Acknowledgment triggered reporting of SFB33.35
MNumber of messages in the diagnostics buffer W
Clack
Synchronization Synchronization Type Time Interval
Inthe PLC: [as siave =] [one =
i the AP [None = [Nene =
O e biE] [one =] [none =
Comection factor lD— ms
Cancel Help
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Step

Activity

Screenshot

3.

Open the shortcut menu of the CP and
select "Object properties...".

[ HW Config - [AS1 (Configuration) - K2_MP_Prj]
O0) Stetion Edit Insert PLC View Options Window Help

=Bl x|
=181 x|

x|

DE38 5 (& |6 e | dedn |23
[l Ur2ALU

1 PS 407 10A -

3 [l cPu 4105H

Xt dor

IF1

Copy
Paste

Insert Multi-Contraller Dewice:

ctrl4C
Chrl

= Replace Object...
| AddMaster System
Disconnect Master System
Master System Isachronous Made
Insert PREEINET 10 System
Disconmect FROFINET IO Systen
PROFIMET I Domain Management. ..
PROFINET IO Topalogy. ..

FROFINET I3 Isachronaus mode

FROFINET 10 Multi-Contraller Devices,

4 Speciy Madule, ..
- Del
4= | [ UR2sLL
—I—I GoTo L

Slot Module  Filter Assigned Modules
1 PS 407 10

Manitor Madify

3 CPUMO o

Displays properties of the seles

Open Objeck With. ..
Change Acoess

Erl+AlEH0
2

Switch to the "Time synchronization" tab.
Select the "Accept time of day on CP and
forward" check box.

Click on the "OK" button to confirm your
selection.

Properties - CP 443-1 - (R0/S5)

SNMP | Web | Diagnostics
Genersl | Addresses | Options  TmeotDay Sechronization | IP Access Protection
- SIMATIC Mod

o

Alt+Return |
%
x|

™ Accept time of day on CP
[V Hicant fime of day on CP And forward

I™ Use comected time
@ Automatic " From station © From LAN

~NTP Modk

= Activate TP time-of-day syrichranization

I Tirme:of-day synchiorieation o the full minute

™ Becept time of day from nonsyrchrorized W servers
|| Forward time of day o station

NP server addresses (IP sddiesses);

Ldd

Edi..
Delete

Update interval [seconds)

(Fiange of values 10 - BE400]

Time zane; |:GMT +01.00) Beriin, Bem, Brussels, Rome, Stockholm, Vienna =

Use the "Station > Save and compile...”
command to save the configuration.

Close the HW Config.

PCS 7 Minimal Configurations
Entry ID: 24023824, V7.1, 02/2018

89




© Siemens AG 2018 All rights reserved

6 ES/OS Master and OS Standby
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Setting up the ES PC station
To run the OS project on the ES, a PC station is created for the ES using the

WinCC application.

Step

Activity

Screenshot

In component view, open the shortcut
menu of the project and use "Insert New
Object > SIMATIC PC station" to add a

new PC station.

=loix|

Fle Edit Insert PLC View Options Window Help

D 3| s 2R da= %= =

|[ < Mo Fiter >

E® K4_MP_MP (Component view) - D:\Mininimal\Projects\K o =] 5]
-2l K4_MP_MP 251
Ep RN et A0
@ K4 MP_Lit Obt
k. CLrl 45
Copy, ChHHE
Faste {4
Delete e/

Insert New Objec SIMATIC 400 Station
Multiproj b SIMATIC 300 Station
PLC b SIMATICH Station
Protect b SIMATIC PC Station
ceess Protechon Other Station
PCS 7 Licanse Information... SIMATIC 55
PGRC
Shared Dedarations »
o - , W
ant Hierarchy PROFIBLS
SIMATIC BATCH »  Industrial Ethernet
PTP
R = Foundation Fieldbus
Object Properties... Alt+Return
57 Program
Preconfigured Station...
o0s
05 (cient)
Shared Dedarations
Batch process cel
Project Documentation
Inserts SIMATIC PC Station at the cursar position. 4

Use the shortcut menu to open the object

properties of the PC station.

=]

File Edt Insert PLC View Optons Window Help

OB &% Bl |dnle %%

-3 KI_MP

=8P K1_MP_Pi
51

@ K1MP_Lb Open Object Chl+Alt+0
Cut Ctrl+X.
Copy Ctrl+C
Paste Chrl+Y
Delete Del
PLC »
Access Protection »
Print »
Rename F2

... Alt+Return

Displays properties of the selected object for editng. 7
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Step Activity Screenshot
3. Change the name of the ES PC station to K|
match the name of the local computer on Gererd | setings | Corfiguation|
the network. = [Esvet
Select the “Computer name identical to PC T R 3
station name” checkbox. Storage location e £l
of the project: -
Author: |
Date created: 10/12/2017 02:25:19PM
Last modified: 10/12/2017 02:25:19 PM
Comment ’ =]
-]
Computer rar
¥ Computer name identical to PC station name
Computer name ESV81
Cancel Help
4. Open the HW Config of the ES PC station 10|
VIa the Shortcut menu File Edit Insert PLC View Options Window Help
: D24 % 2R dn|e %% > [[<Ho Fiter >
¥ K4_MP_MP (Component view) - D:\Mininimal\Projects =]
= {28l K4_MP_MP
=] Open Object Cirl+AIt+0
Ut Chrl¥
{1 Shared Declarations Copy) ChriH-C
@ K4_MP_Lib PBaste kel
Delete; el
Access Protection »
SIMATIC BATCH »
Rename F2
Opens selected object. 4
5. Insert a "WinCC application” & (0) PC
(and a network card) of type “CP1623" n WintC Appl. a
from the object catalog (View > Catalog). 2 CP 1623
3
4
5 .
6
7
8
9
10
1
12 hd|
6. Under “Subnet”, choose the plant bus or E
create it by clicking on the “New..." button. Gonera Parameters |
Assign the corresponding MAC address to i
the CP1623.
Deselect the "IP protocol is being used”
checkbox. i B Do
ubnet ma:
Click on the “OK” button to confirm your Glllz=pucs
settings. e
Subnet:
— ot networked — New
Properties...
Delete
Cancel Help
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compile it.
Close the HW Config.

menu item to save the configuration and

Step Activity Screenshot
7. Open the shortcut menu of the CP1623 5| () PC
and select "Object properties...".
[ WinCC Appl.
4 Copy Ctrl+C
& Paste Chrl+Y
&
7 Replace Object...
3 fidd(Master System
g Discommeck Master System
10 IMastet System Isochranous [Mode
11 Insert PROFIMET IG) System
12 Discommeck PROEIMET I8 Systern
13 FROFIMNET [0 Damain Management., ..
14 PROFIMET [0 Topalagy ..
15 FROFINET IC Isochronous mods
16
17 Specify Module, ..
18 Delete el
Go To 3
Filter &ssigned Modules
I onitorfMadify:
Edit Symbals. ..
Object Proy . Alt+Return
Open Object With, .. CErH-AlEH O
Change Access r
8. Switch to the “Options" tab and select the []
"Time of day” checkbox. General | Assignment Options | Diagnostcs |
R " " " Time-of-Day Sy
Click on the "OK" button to confirm your s
selection. " Wast (i sencis]
 Slave fime receiver)
Send Kespalives for Connection
(l? Aetivate (30 seconds) ‘
Settings for TCP protocol
’VNDIS IP address ‘
Cancel Help
9. Use the "Station > Save and compile..."

our example.

10. Delete the OS of the PC station of the ES
Optionally | in SIMATIC Manager as it is not needed in
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Setting up the OS standby PC station

Step Activity Screenshot
1. In component view, open the shortcut =10j ]

menu of the project and use "Insert New
Object > SIMATIC PC station" to add a
new PC station.

File Edit Insert PLC View Options Window Help

D& 25| % i sl %% = [<NoFter>
£ K4_MP_MP (Component view) -- D:\Mininimal\Projects\K: o [ 5

0 51
=8 Open Object Ctl+Alt+0
@ o MP_Lit
cut el
Copy 4
paste 4
Delete Def

SIMATIC 400 Station
SIMATIC 300 Station
SIMATIC H Station

SIMATIC P o

Access Protection Dl

PCS 7 License Information. .. SIMATIC 55
PG/PC

Shared Dedarations 3
WP

Plant Hierarchy [

SIMATIC BATCH »  Industrial Ethernet
PTP

Rename F2

Foundation Fieldbus
Object Properties. .. Alt+Retun

57 Program
Preconfigured Station...

os
05 (Client)

Shared Dedarations
Batch process cell

Project Documentation

Inserts SIMATIC PC Station at the cursor position.

2. Use the shortcut menu to open the object
properties of the PC station.

[E7] STMATIC Manager - [K1_MP (Component View) - d:\K1. =loix|

(%] File Edit Insert PLC View Options Window Help

[De |2 s e m e %]

E-{=8] K1_MF Configuration
=8 KI_MP_Pij
451
Open Object Ctri+Alt+0
Cut Ctrl4+X
Copy Crl+C
Faste b4
Delete Del
PLC 3
Access Protection »
Print 13
R F2

Displays properties of the selected object for editing.

3. Change the name of the OS server PC
station to match the name of the computer
on the network.

Select the “Computer name identical to PC
station name” checkbox.

Properties - SIMATIC PC Station

General | Settings | Corfiguration |

Name: [sv

Project path ‘KT_MF_Frj\ESVFH ﬂ
Storage location \K1_MP_Pr E
of the project: -
Author ||

Date created: 10/12/2017 02:25:19 PM

Last modfied: 10/12/2017 02:30:47 PM

Comment =l

Computer name
¥ Computer name idertical to PC station name

Computer name: 53

Cree | s
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6.3 Step-by-step configuration

Step Activity Screenshot
4, Open the HW Config of the OS standby =lo1x
PC Statlon Vla the ShOI‘tCUt menu. File Edit Insert PLC View Options Window Help :
D |86 =ede %2 <M Fter
% K4_MP_MP (Component view) — D:\Mininimal =10 x|
E-{Z8 K4_MP_MP
E@ K4_MP_Pij Open Object Cirl+Alt+0
il cut Cirl
% E\S/VST Copy. Ctr\:c
\ B Shered Declarations | | ¢ ki
- @ K4_MP_Lib Delete Dl
Access Protection >
SIMATIC BATCH 3
Rename F2
Opens selected object. 3
5. From the object catalog (View > Catalog) = (D) PC
inse(t a ‘.'WinCC application (not a WinCC q eGP, B
Application Stby!)" and a network card of 3 CP e
type "CP1623". 3
4
5 1.
&
7
[
9
10
11
12 hd
6. Under “Subnet”, choose the plant bus or =]
create it by clicking on the “New..." button. Generd  Paranete |
Assign the corresponding MAC address to Del el 442 edss e Sl
the CP1623. A sdrecs
Deselect the “IP protocol is being used” W Pz ez
IP address: [1728102 = Do ot tse 1outer
ch.eckbox. o . e L
Click on the “OK” button to confirm your O Lz ot
settings. s
Subnet:
— ot networked — New
Properties..
Delste
Cancel Help
PCS 7 Minimal Configurations
Entry ID: 24023824, V7.1, 02/2018 94




© Siemens AG 2018 All rights reserved

6 ES/OS Master and OS Standby

6.3 Step-by-step configuration

Step Activity Screenshot
7. Open the shortcut menu of the CP1623 Z(OpPC
and select "Object properties...".
3 Copy Cirl4+C
4 Paste Chrl+
5
[ Replace Object...
7 AddMaster System
3 Disconmect Master System
5 IMaster System Isochranous Mode
10 Insert PROFINET 10 System
" Discannect BROFINET 16 System
12 PROFINET [ Domain Management. .
PROFIMET Lo Topolagy ..
FROFIMET I sochronaus mode
Specity: Module, .,
Delete Del
Go To 3
Filter Assigned Modules
Iomitor Modif:
Edit: Symbals. ..
Object Properties... Alt+Return I
Open Object With, .. Ch -l
Change Access 3
8. Switch to the “Options” tab and select the E
"Time of day” checkbox. General | Assignment Options | Diagnostics |
Click on the "OK" button to confirm the e
. AR Ty
settlng. € Master (tme sender]
@ Slave fime receiver)
Send Keepalives for Connaction:
[F Asctivate (30 seconds] ‘
Settings for TCP pr |
’VNDISIP address ‘
T Help
9. Save and compile using the "Station >
Save and compile..." command.
Close the HW Config.
10. In SIMATIC Manager, open the properties x|
dialog of the Standby OS. Generl Torgt 05 and Sandoy O3 Conputr |
Switch to the "Target OS and Standby OS Pt to the Target 05 Compuler
Computer" tab. [ |
Select the "Create/update archive tags" Symbolic computer name
checkbox and clear the “Transfer to [os.siey
external archive server” checkbox. Standey 05
Click on the "Search..." button. e d
[ Create/update archive tags
[ Transferto extemal archive server
If target OS5 computer is identical to ES computer:
Assign archive server
oK Aoply Cancel
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Step Activity Screenshot
11. Use the drop-down list to navigate to the £
. ~ Network + SV - Projects = - earch Proje 2]
shared project folder of the Standby OS ) (1 b o ke | j
« age le name: | & by |
(see 6.3.1 Preparatory activities). - 3
Click on the "Save" button.
A
12. In the "Path to Target OS Computer” input x|
field, check again the whole project path. Ganerl| Taget OS and Sanchy O Computer |
Click on the "OK" button to confirm this. Path o the Targel O Compuer
[\\SV\Projects\OS\0S mep Search
Symbolic computer name
Jos_stey
Standby OS
[<none > =
¥ Create/update archive tags
[~ Transferto extemal archive server
If target OS computer is identical to ES computer:
Assign archive server
=
13. Click on the “Yes” button to confirm the =

information dialog.

After changing the target path or after assigning a standby 05,
l 4, the online modification capability gets lost.

Additionally, the 05 needs to be newly compiled, the packages for
the dients are to be updated and an entire loading
of all assigned OS servers needs to be executed.

Do you wish to execute the changes?
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Configuring the PC stations

The "Configure PC station" transfers project configurations to one or more target
stations. First configure the local Station Configuration Editor of the ES and then all
the other PC stations connected to the plant bus.

Step

Activity

Screenshot

Execute the Station Configuration Editor of
the ES. To do this, select the PC station of
the ES and in the shortcut menu choose:
"PLC > Configure...".

~iBix

Fle Edit Insert PLC View Options Window Help
D |82+ & B dno %) % ¢
¥ K4_MP_MP (Component view) -- D:\Mininimal\Projects\K

5 @l FA_MF_MP Dot rame: Syrmboic name: Type
£ Bp KaMP_Fi Bl Corfigurstion PC station
AS1 WInCC Appl. WinCEC Apy
8 e

o3 5  OpenObject Crri+Alt+0 ki
[BEY v

cut Cirl+x
Copy ctrl+e
Paste 4

Delete Del

Donrias criat

Configure..

fe=eiein Gompleand Dovload Chiecis?S

— |

3
Print »
SIMATIC BATCH 3

Rename F2
Object Properties... Alt+Return

B

Configures a selectable target computer according to the structure or the selected PC station (initialjreconfig ./

Under "Accessible computers:” choose the
PC that you want to configure.

Note

If you chose the "PC name identical to PC
station name" option for the PC station in
the “Object properties”, the system displays
directly in the component configurator the
target PC to be configured.

Using the "Display..." button, you can
display the current configuration of the PC
station.

Click on the “Configure...” button.

x|

Local network connection:

I Terminal bus j

Wpdate |

Accesszible computers:

ESWE1
v

¥ se configured computer name

Target computer:

|ESVB1

Dizplay... |

Messages:

LCloze | Help |
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Step Activity Screenshot
3. In the window that appears, you can see =]
how the PC station is configured. Station Esen
Click on the "OK" button to confirm this [Indes [ lame [ Tipe [ Status [ Couse -
tt 1 E WinCC Appl. WANCC Appli...
s€ Ing' 2 E CP 1623 CP 1623
3
4
5 |
g
7
El
El
10
1
12
13 S
| J _>I_I
@ The configuration is posgsible. The configuiation can be seen in the list
abave.
Cancel Help
4. Click on “OK” to confirm the information ——— |
dialog.
If the component configuration is changed, the entire PC station
' % wil be reconfigured and the existing database is lost.
" This can take several minutes.
Make sure that no communication or diagnostics is active over a
compenent in the current configuration.
s |
5. In the bottom window, you then see the x|
message: .
" " Local network, connection:
Transfer completed successfully". | =
. . . Terminal bus i
Close the configuration dialog.
Accessible computers: &I
ESWET
S
¥ Uze configured computer name
Target computer:
JEsvat
Display... |
Meszages:
Configuration running.
ESWET:
Transfer completed successfully.
Configuration completed.
Cloze | Help |
6. Configure the Station Configuration Editor
of the Standby OS as shown in steps 1 to 5.
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Configuring and loading AS-OS communication

In the following section, the connections between the PC stations and the AS are
configured in NetPro and loaded in the individual stations.

Note In the case of a granular station configuration, you must merge the subnets of

the individual sub-projects first.

Step Activity

Screenshot

1. Open NetPro.

Highlight the WinCC application of the ES
and open the shortcut menu.

Select "Insert New Connection".

£ NetPro - K4_MP_Prj

Network Edit Insert PLC View Options Window Help

=10l

Eaa A=A A T I = L

55 K4_MP_Prj (Network) -- D:\Mininimal\...\K4\K4_MP_MP\K4_|

AS1

CPU_1DF IFN- (FN. [CF IFNIO
410-5H | X5 |IC-KE 4431}

:

2

PlantBus
Industrial Ethernet

i
]
|+ {|3¢

I

sV
WinGC [P
opl | 1823

Downioad to current project 3

Rearrange

| Inserts anew cor  Object Properties.. Alt+Return

PCinternz

2. In the "Connection Partner" window, select
the CPU of the AS.

Make sure that an “S7 connection" is
selected under “Connection”.

Insert New Connection

x|

— Connection Partrner

EI{E] I the cument project
=P K4_MP_Prj

CPU 410-5H

E =
- [Unspecified)

- &l broadcast stations

- Al multicast stations
[]--@ I the mulkiproject: K4_MP_tP
@ I unknown project

Breject: |K4_MP_Prj

¢

Station: IAS‘I

todule: |CPL 410-5H

r— Connection

Tvpe: I 57 connection

W Display properties before ingerting

=

ak. I Apply Cancel |

Help |
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Step Activity Screenshot
3. On the “General" tab under "Connection E
identification”, change e EE
the “Local ID:" to a descriptive name like G e
AS1, for example. 7 Garigired ot ore e [psT
¥ | Establish an active conmestion VFD Name:
Click on the “OK” button to confirm your ;E:‘:.gmd Je— [finCC 2o
settings.
—Connection
Logal Partner
Eofes \EVS\rYng/ﬁpp\ |Q|S:LI4135H
Interface [cr 1623 | [cpaa31.Pr-ORI/SS) =l
Subnet [PlantBus [industrial Ethemet] [PrantBus [industrial Ethemet]
Address: [oroc-2855EF-27 [oe-00-06-01-00-00
Address Details.
= Help
4. Also create a connection between the x|
Standby OS and the AS by repeating steps
1to 3. - Compile
When doing this, it is important that the (" Compile and check everything
connection has the same name as the (~ Core changes oo
connection of the ES to the AS.
After this, use the ""Network > Save and
Compile..." menu item to save the ITI Cancel Help
configuration and compile it.
Select the "Compile and check everything"
option button and click on the "OK" button
to confirm your selection.
5. Select the ES and download the T e o Hep
connections via the shortcut menu: AT T T I WL .
"Download to current project > Selected | |
Stations". ) e
Download the Standby OS and the AS in — o
the same way. .
Then, Close Netpro Industrial Ethernet]
Compiling and loading the user program
Compile the S7 program and download it to the AS.
Compiling the OS project

Compile the OS project of the Standby OS in SIMATIC Manager.
Make sure that you make the correct OS assignment to the server in plant view.
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6.3 Step-by-step configuration

6.3.3 OS configuration

Configuring the OS on the engineering station

On the ES, you must still switch from a multi-user system to a single-user one and
make the settings for redundancy and time synchronization.

Note In this particular configuration, it is necessary to complete the redundancy
settings in WinCC Explorer of the Standby OS after the entire download

completes.

Step Activity

Screenshot

1. Open the OS project of the Standby OS in
the ES.

In the open WiInCC Explorer, highlight the
OS project and choose “Properties” in the
shortcut menu.

2= WinCC Explorer - [

Edit Wew Tools Help

=10f x|

FEPE [ e

----- 11 Tag Management

..... .-’h-. Graphics Designer
----- ¥ Alarm Logging
----- J_U Tag Logging
ook Report Designer
= c .
----- J v Blobal Script
----- Text Library
..... E :=-'b Text Distributor
----- iﬁ User Administrator

----- @ Redundancy
----- J_U User Archive
----- '—] Time synchronization

1
g Cross-Reference

----- 'i!‘.rf,l‘ Picture Tree Manager
L1 Lifebeat Monitoring

[ 14 &

-, 05 Project Editor

g% BFC

----- P web Navigator

Press F1 for Help,
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6.3 Step-by-step configuration

Step Activity Screenshot
2. On the "General" tab under “Type:”, zl
choose "Single-User Project” from the Operating Mode | User Interface and Design |
drop'dOWn ||St. General | Update Cycles I Shartcuts I Options
General data of the cument project.
Type: =
Creator: I";'u'inCC-Projed-Manager
Creation date: |12.-"1 7/2014 10:36:19 AM
Changed by: IWinCC-ijed-Manager
Last change: I'IE.-" /2014 1:01:09 PM
Wersion: I
GUID: CC_0S 5 14 12 17_10_36_18
Comment: ;I
=
0K | Concel |
Confirm your settings and the displayed x
message by clicking on the "OK" button.
% A change from a multi-user to a single-user or WinCC dient project
will delete all configured dient computers from the computer list.
Click on <0K > to perform this change,
or on <CAMNCEL > to keep the multi-user project.
x|
3. Activate OS project option "Allow activation x|
on ES" from the "Options” tab. This setting Operating Hode | User Interface and Design I
allows runtime to be activated in the ES. Genersl | UpdateCycles |  Shoreuts Options
Then click on the "OK" button. Additional project options
W Allow activation on ES
i elp available in Runtim:
¥ Color conversion when printing messages
¥ Export text files as Unicode
[~ | tultiuser engitesting Fesources |
C scripts with language setting "Dynamic” in Runtime:
Operating system language for non-Unicode programs j
This option allows you to access the Online Help in runtime.
0K I Cancel
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6.3 Step-by-step configuration

Step Activity Screenshot
4. Click on_the "No" b_utton to prevent the Change project type B
startup list from being deleted.
Confirm the displayed message by clicking - _
on "OK" |" 1 The project type was changed.
’ ' Do you want to delete the startup list?
Yes
5. Open the "Redundancy" editor. x|
General | User Archive |
Server:
Select the "Activate Redundancy" =
Checkbox_ ¥ Default Master
Redundart partrer server:
Select the "Default Master" checkbox. - e
If necessary, adapt the redundancy b G
properties in "Optional Settings" to meet Corneciion to redurdant patner via network adapler
your requirements. tere =
In the drop-down |i5t, select the connection Connection to redundant partner via serial interface (optional) Jeomi =]
path that is used to connect the Master OS
and the Standby OS " Synchronize all data of the outage period
% Synchronize failures of last |2 days only.
Optional Setting:
[V Synchronization of Tag Logging after the partnier server comes back online
¥ Synchronization of Alarm Logging after the partner server comes back online
[V Online synchronization for Alamm Logging
¥ Synchronization after disnuption of the process link (Tag Logging + Alamm Logging)
W WinCC client switch in case of a process connection emor
Enables the synchronization for all specified options and user archives:
[V Activate Redundancy
0K | Coned | Heb |
6. To complete the redundancy settings for x|
the ES, the partner server must be still
selected.
To do this, click on the "Search ..." button rer—
and select the Standby OS as a redundant e ’;irsu
partner from the network. -
Cllc_k on the “OK” button to confirm your .; Esva1
settings. 8 EL3D
N sV
s
oK I Cancel
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6.3 Step-by-step configuration

Step Activity Screenshot
7. Double check all of the options before [
clicking on the "OK" button to confirm the e =
redundancy settings.
[¥ Default Master
Redundart partner server:
|sv Browse.
~Local Computer Setting:
Connection to redundsnt partner via network adapter:
None =l
Connection to redundant partner via serial interface (optional): COM1 B
" Synchronize all data of the outage period
% Synchronize failures of last |2 days only.
~Optional Setting
[V Synchrenization of Tag Logging after the partner server comes back orline
[V Synchrenization of Alam Logging after the partner server comes back online
¥ Online synchronization for Alam Logging
|V Synchronization after disruption of the process link (Tag Logging + Alam Logging)
¥ WinCC client switch in case of a process connection emor
Enables the synchronization for all specified options and user archives:
¥ Activate Redundancy
ok | Conedl | Heb |
8. Click on the “OK” button to acknowledge x|
the message.
9. Open the "Time Synchronization" editor. @ Time Synchronization - [0S_Sthy.mep] 21l
Here, select the "Synchronization via ~ General Setlings
System Bus (Master, Slave)" checkbox. I Use time receive wiilty
Under "Access point 1”, choose ™ Deactivate time synchrarization Cancel |
"CP1623(1SO)" and select the "Master"
radio but’[on ) I Spnchranization via Terminal Bus [Slave]
Clle on the uOKu button to Conﬁ m yOUr =) Wse the tme from a connected WinCE senver
Settings (= [Use the time from a specific computer:
Earmputer 1: I J
NOTE Computer 2 I J
If yOU Conﬁgure Station t|me =) LLet time be set by external [3rd - party] components
synchronization on a different computer,
h . ts are not known WhICh —Iv Sunchronization via System Bus [Master, Slave]
the access pOIn A ' —Access point 1
means that they are not available in the & Master
. . |cP1E23150) =l
drop-down list. To choose the access point  Slave
regardless, select the "Display symbolic
name of the access point" checkbox and [EAEe=s Rl .
. . i
then choose the appropriate access point. <Hane> = - Slas -
EVE:
™ Display spmbolic name of the access point
— Process controling messages Project documentation—
¥ Send once Print I
Send every I _I: mikutes &I
Setup I
10. Close the OS project.
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6.3 Step-by-step configuration

Downloading the OS project to the Standby OS

Once redundancy and time synchronization have been configured on the ES and
you have closed the OS project again, download the OS project to the Standby OS.

download is required.

Click on the "OK" button to start
downloading.

Step Activity Screenshot
1. In SIMATIC Manager, highlight the =l
« File Edit Insert PLC View Options Window Help
Standby OS and choose “PLC -> SRR B R s
Download" in the shortcut menu. £ K4_MP_MP (Component view) - D:\Mininimal\Projects\K: =T
@l K4 MF_MP Object name P Assignmert Tvpe
1P kA_MP_F 5 AMT1 PlantRMT1 Fictue
As1 5 RMT2 Plant\RMT2 Piture:
B Open Object ctri+Alt+0
Shared Declo
%‘,Mﬂuh cut Crlak
Copy Ctrl+C
Paste Chrl4+i!
Delete Del
Insert New Ohject 3
PLC
Access Protection 3
Compile Cirl+8
Display compilation log...
Display load log...
Generate server data
Assign OS server...
Start OS simulation
Import WinCC objects
Print r
Plant Hierarchy »
SIMATIC BATCH »
Rename F2 LI
Downloads current object to the PL Object Properties... Alt+Return Z
2. For the first OS project download, an entire x|

Target system: \\SViProjects\ps_stby\os_stby.mcp

- Scope
* The entite WinCC poject

€ Changes Details |

I~ Start compilation before downloading

The entire WinCLC project will be transferred ta the runtime 05. T arget system will be
clozed automatically before download starts,

[0]:4 I Cancel Help
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6.3 Step-by-step configuration

project is located in the specified folder on
the Standby OS.

Click on the "OK" button to confirm the
message that is issued.

Step Activity Screenshot
3. After successful downloading, the OS

Download ta target system waz completed successfully.

I Emor

< hohe >

0K

Canoe|
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6.3 Step-by-step configuration

OS configuration on the Standby OS

In this particular configuration, it is necessary to make the redundancy settings after
the download completes.

Generally, we would advise you to check the project settings after the project has been
downloaded to the target systems.

Note Normally, all configuration work is carried out on the ES to ensure consistent
data management. This means that no WinCC engineering licenses are needed
on the OSes. However, each time WinCC Explorer is opened, a license-free time
window of two hours is available for WinCC configuration work.

Step Activity Screenshot
1. Open the OS project on the Standby OS
under the shared project folder.
2. Open the "Redundancy"” editor from the |

shortcut menu.

Click on the “Search..." button to select the

€ Network
ES computer as the redundant partner. .

OK I Cancel

3. Clear the “Default Master” checkbox here. E
Check whether you have selected the GZ”:;' —
desired checkboxes under "Optional v
Settings". e e
In the drop-down list, select the connection o —
path that is used to connect the Master OS
and the Standby OS. R
Nane =

Click on the “OK” button to confirm your T T R T T S e [eomi =]
settings.

™ Synchronize all data of the outage period

@ Synchronize failres of last |2 days only.

Optional Setting:

[ Synchronization of Tag Logging after the partner server comes back online

[V Synchrenization of Alamm Logging after the partner server comes back online

[¥ Online synchronization for Alam Logging

[¥ Synchronization after disnuption cof the process link (Tag Logging + Alam Logging)
[¥ WinCC client switch in case of a process connection emor

Ensbles the synchronization for all specified options and user archives
¥ Activate Redundancy

0K | Cancel Help
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6.3 Step-by-step configuration

Step Activity Screenshot
4. | Click on the "OK" bution to acknowledge
the message.
:' The changas will take effect after WinCC is started.
5. Open the "Time Synchronization" editor
from the shortcut menu. " General Seffings
[~ Use time recsive utility \LI
CheCk or Select the "SynChronization Via [~ Deactivate time synchronization Cancel |
System Bus (Master, Slave)" checkbox.
Under "ACCGSS point 1!!, CheCk or SeleCt —I Sunchronization via Terminal Bus [Sl.ave]
"CP1623(ISO)" and the "Master" radiO & Wse thie e o e cormested S/HEE server
bUttOn. ) Wee the tre fom aspesiic computer:
[Earmputer s I J
Always click on the "OK" button to confirm Coniputer % [
yOUr Settings, ) [Let e be sebby evterral (B - part] Eampoanerts:
—I¥ Sunchronization via System Bus [Master, Slave]
—Access point 1
@ Master
CR1EZ3150 -
I = = " Slave
—Access point
£ baster
Mone: -
_ = ] Slave
™ Display symbolic hame of the access point
 Process controling messages Froject documentation——
¥ Send once LI
Send|even I =l rifutes ﬂl
= Setup I
6. If you have made project changes in
WinCC Explorer, close the OS project and
open it again for the settings to take effect.
6.3.4 Activating runtime
First activate the OS project on the ES and then on the Standby OS. Before
activating the second runtime, it is advisable to wait until the boot process of the
first one has completed.
Online synchronization is active immediately.
Mutual synchronization of archives starts after ten minutes.
6.3.5 Particularities when loading OS project changes

Loading changes

To download changes, runtime must be stopped on the ES when compiling the OS.
These can then be re-activated to test the modified OS functions.
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6.3 Step-by-step configuration

CAUTION  Depending on the changes that are made, if runtime remains active during OS
compilation, the system may not download changes completely, which will cause
errors. If this happens, only an entire download is possible.

For the downloading process, runtime must be terminated and the OS Project must
be closed. As a result, it is not possible to take operator actions on the ES
computer during this time.

Complete download
For a complete download, the following must be always observed:

1. Runtime must be deactivated on both PC stations and the OS project must be
closed.
2. Before re-enabling runtime on the Standby OS, you must make the

redundancy settings again.
To do this, repeat the steps in the table on page 107.
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6.3 Step-by-step configuration

7 Expansion with the PCS 7 OS Web Option

Positioning

To control automated processes via the Internet/Intranet, SIMATIC PCS 7 provides
operating and monitoring options: what are known as the "Web Options".

This chapter describes configuration of the Web Option on an ES/OS Single
Station. The instructions can also be used to expand the following minimal
configurations:

e ES/OS Single Station (Chapter 3)
e ES/OS Master and OS Standby (Chapter 6)

Note To expand the redundant Single Station configuration with the Web Option, the
ES/OS station in the following example has been configured as a Web Server.
The partner OS could also be used in the same way as a Web Server. The
functionality for the Web clients is unchanged.

Redundancy of the operator stations is not available for Web clients. If the OS
with the Web Server option is in the STOP status, the Web clients do not have a
connection to the process either.

Function
All of the relevant pictures and scripts are stored on the Web Server to make it
possible to display or run them via a Web client.
The Web client accesses the system data provided by the Web Server via a
TCP/IP connection. The user interface matches the appearance of a standard OS
client with an overview, work, and key areas.
Amongst others, the functions below are available via Web:
e Operator control and monitoring functions, which are also used on an OS client
¢ Message lists that are called on a user-dependent basis, just like on an OS
client. Messages can be acknowledged on a user-dependent basis.

¢ Displaying the picture hierarchy according to the plant hierarchy
e Group display function including the "loop-in-alarm" function
e Enhanced status display

Note For further information about the PCS 7 Web Options, see the following manual:

"SIMATIC PCS 7 Web Option for OS (V9.0)"
https://support.industry.siemens.com/cs/ww/en/view/109746536
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7.1 Web configurations

7.1 Web configurations

In our example, configuration of the Web Option is an extension to the hardware
and software configurations in chapter 3, "ES/OS Single Station" and chapter 6
"Master ES/OS and Standby OS".

ES/OS Single Station with OS Web Server option

To operate and monitor the system process, the OS Web clients use Internet
Explorer to get their project data from the Single Station with the OS Web Server
option via the Internet/Intranet.

e N

Intranet/Internet

ES/OS + OS Web Server

Plant bus
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7.1 Web configurations

Master ES/OS with OS Web Server option

To operate and monitor the system process, the OS Web clients use Internet
Explorer to get their project data from the Single Station with the OS Web Server
option via the Internet/Intranet.

In addition, the system process is set up on a redundant basis to offer the greatest
possible protection from failure of system operation.

CAUTION  Redundancy of the operator stations is not available for Web clients.
If the OS with the Web Server option is in the STOP status, the Web clients do
not have a connection to the process.

Web Clients

il AT

Intranet/Internet

OS Single
Station

ES/OS + OS Web Server

Redundancy

COM-Cable

Plant bus
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7.2 Web-specific hardware and software requirements

7.2

Web-specific hardware and software requirements

Single Station with Web Server option

Web Client

Note

Property

Requirement

Operating system

e Windows 7 Ultimate/Enterprise SP1 (64 Bit)
e  Windows 10 Enterprise 2015 LTSB 64-bit
e  Windows Server 2012 R2 Standard Edition (64-bit)

You can find further information in the document entitled
"SIMATIC PCS 7 process control system PCS 7 Readme V9.0
(online)"
https://support.industry.siemens.com/cs/ww/en/view/109744312

Hardware

e SIMATIC PCS 7 ES/OS IPC847D BCE
e SIMATIC PCS 7 ES/OS IPC847D IE

You can find information on this topic in the document entitled
"SIMATIC PCS 7 process control system PCS 7 Readme V9.0
(online)"
https://support.industry.siemens.com/cs/ww/en/view/109744312

Software

e Internet Explorer
¢ Internet Information Services (IIS)

Miscellaneous

Fast access (>= 64 kbps) to the Web Client via Internet/Intranet or a

TCP/IP connection

Property

Requirement

Operating systems

e Windows 7 Professional SP1 (64-bit) (English only)
e Windows 7 Ultimate/Enterprise SP1 (64-bit)

e Windows 10 Enterprise 2015 LTSB 64-bit

e Windows Server 2012 R2 Standard Edition (64-bit)

You can find further information in the document entitled
"SIMATIC PCS 7 process control system PCS 7 Readme V9.0
(online)"

https://support.industry.siemens.com/cs/ww/en/view/109744312

Minimum hardware
requirements

No PDAs, tablet PCs etc.

Software

Internet Explorer

Miscellaneous

a TCP/IP connection

Fast access (>= 64 kbit/s) to the Web client via Internet/Intranet or

Choose the version of Internet Explorer to match the PCS 7 version. You can

find more information by visiting the “Compatibility Tool for Automation and Drive

Technology” at:

http://www.siemens.de/kompatool
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7.2 Web-specific hardware and software requirements

Software licensing

The following section lists the various additional software/license packages that
you need for the selected configuration.

Component Software/license packages

Single Station with Web Server option e SIMATIC PCS 7 Web Server Basic
e SIMATIC PCS 7 Web Server license (cumulative)
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7.3 Maximum number of Web client connections

7.3 Maximum number of Web client connections

In one OS Single Station, it is possible to operate a maximum of three Web clients
per Web server at the same time.

7.4 Configuring the OS Web Server

Configuration steps on the ES

Publish pictures using Web View Publisher

Configure user rights, start screen, and the language of the website in the User
Administrator

Download and compile the Web server

Publishing OS data

The Web Publisher makes it possible to publish pictures and scripts on the OS
Web Server, which are intended to run later on the Web clients. In this connection,
the following actions are carried out:

Project data is compressed and saved
Picture windows are converted to Internet-enabled ActiveX components
Scripts are converted so that they run on the Web

Requirements

To publish the Web Server data, the following requirements must be met:

Note

The hardware and software requirements mentioned in chapter 7.2 have been met.

The "PCS 7 Web Server" software package have been installed on the ES/OS
Single Station.

The PCS 7 Project is available and fully configured.

"OS compiling" has been carried out.

The scripts that are accessed by the Web clients are present.

Process pictures do not contain double underscores (e.g. yy__xx.pdl).

Tag names in plain text (quotation marks) within C scripts do not contain any spaces.

In a Single Station, only one publishing process is needed to publish local data
on the Web Server.

For information on the topic of “supported script standard functions”, refer to the
“SIMATIC PCS 7 Web Option for OS (V9.0)” manual.
https://support.industry.siemens.com/cs/ww/en/view/109746536

(Chapter 8.1.2 "Web-enabled functions for the Web Option for OS")
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7.4 Configuring the OS Web Server

7.4.1 Publishing project data
Step Action Note
1. Open the OS project of the OS Web Server =loix
in WinCC Explorer. . S
Using the shortcut menu of the "Web %’5!5%fh?std*’:::“;f:éﬁi%f%;sﬁﬂ%fi%%&fisﬁi}“’“ﬁ
Navigator" editor, select the "Web View
Publisher" command.
The system opens the "WinCC Web
Publishing Wizard - Introduction” dialog
box.
Click on "Continue".
[] Skip this screzn in the future.
[Feance | [ wmeek |[wet>—] [ Finisn ]
2. This opens the "WinCC Web Publishing b rccretpiins wnt et SIEME‘S‘;‘
Wizard — Select files and folders" dialog
bOX Select the folder containing your WinCC pictures and the folder of the
Clear the "Server Prefix" checkbox, since T
you want to publish local data.
Accept the default destination and source
paths If you rea”y Want to Change the D:\Projects\WEBNS_MP_MP\5_MP_Pr\wincpro"OS\
respective path, click on the button behind
the grayed entry fields. Navigate to the Pubihing folderof the WinCC Web:
desil’ed target or source foldel’. D-\Projects\WEB\5_MP_MP\5_MP_Prj'\wincproj\05\WebNavigator\
. . Diagnostics:
Click on "Continue". D) Sraw hidon ciecs
[ cancet ] [ <Back || Met>]| [ Finsn ]
3. The system opens the "WinCC Web =lolx|
Publishing Wizard - Select pictures" dialog RIEMIENS
bOX. Add X Remove EEl- } |
_ R
Select all of the pictures that you want to I tiame L -
. A . #L@1001.PDL
publish. We recommend publishing all of i
the standard pictures. Aol

Use the ">>", "<<" ">” and "<" buttons to
select the pictures.

Click on "Continue".

&1 @AamGoneOp.PDL
&% @MamHidden PDL
& @AamHiding PDL
&L @AamJoumal PDL
&L @MamNen PDL
&2 @MamNewOp.PDL
A @Mam0ld.PDL
L @Mam0IdOp PDL
4 @MamOneLine PDL
% @AamOperstion PDL
L @MamProess PDL
% @AamQut PDL

[ cancet | [ <Back |[ New> | [ Finisn
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7.4 Configuring the OS Web Server

Step

Action

Note

4.

The system opens the "WinCC Web
Publishing Wizard - Select functions" dialog
box.

Select all of the functions that you want to
publish. In the pictures, only the scripts are
available that you selected during the last
publication process. This means that you
must select all the necessary functions at
every publication process.

Use the ">>", "<<", ">” and "<" buttons to
select the functions.

Click on "Continue".

i add X Remove [EEl-

|

>

common’Commor_UpdateGiioupT ag
common\s7f_Operatiorloa fot
sommontS7F_Operationl ogBool fot
sommonts?f_UpdateGroupT saname:
57iilhs71_OpenSaletyFaceplaleEx.fot
SaletyMatix\Openf acePlateE ot
SaletyMatix\OperF acePlateE x V6
SalelyMatix\ResizzWindowEx et

<

!I

¥ WinCC Web Publishing Wizard - Select functions. _1of x|

SIEMENS

| cancet | [ <Back ][ WNem> | [ Fimsh |
5. The system opens the "WinCC Web S|EM£‘NE‘;|
Publishing Wizard - Referenced graphics" _
dialog box. ke B . |
. -
Select all of the graphics that you want to I [ — I -
publish. We recommend publishing all of e
. > B r_2_0bmp
the graphics. demte
Use the ">>", "<<", ">", and "<" buttons to i
select the graphics.
Click on "Continue".
5 @bfbom28g bmp
5] @Client bmp
&l @Config bmp
:@‘@cﬂmg_rhmp -
| concel | [ <Back |[ Nex> | [ Finsh |
6. The system opens the "WiIinCC Web S|EMEINEI;I
Publishing Wizard - Finish" dialog box.
Click on the "Finish” button. The Wi Web Publsing Wiz s frshed collctng rfomaan
To publish your pictures. press Finish
List of result
Status | Name. | Type |
[ Concet | [ <Bock [ mexs | [ Fimish ]
imx
SIEMENS
The WinCC Web Publishing Wizard is finished collecting information.
To publish your pictures, press Finish,
List of result
Stotus | Name | Type |
¥)  @1001PDL Sereen
¥)  @@ConfigTypicals PDL Sereen
) | @AamEmengency.pdl Sereen
) @AamEmergencyOp pd Screen
[©) @MamGone. PDL Screen
) @AamGoneOp PDL Screen
&) @AMamHidden.PDL Screen

—

[coneet |

| <oek [ Wext> ] [ Ciose
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7.4 Configuring the OS Web Server

Step

Action

Note

7.

Pictures and functions that contain faulty
scripts are identified by a red cross.
Double-click on each faulty picture to open
the picture in the "PdIPad" editor and to
correct it.

Once the publishing process is complete,
click on the "OK" button to confirm the
message.

+ WinCC Web Publishing Wizard - Finish

‘The WinCC Web Pubiishing Wizard is finished collecting infonmtion

To publish your pictures, press Finish

| WinCC Web Publishing Wizard x|

Performance em
TANK1.EMF
TANK2EMF
TANK3.EMF
VARIANT EMF
wartung enf.

0 The picture(s) have been published successfuly.

—

PNG

WeblntedaceDeactivated PNG

—IBix]
SIEMENS

Cancel | [ <Bock [ Wemz | [ Close ]

The system lists the transferred pictures in
the "WinCC Web Publishing Wizard —
Finish" dialog box.

Click on the "Finish” button.

# WinCC Web Publishing Wizard - Finish

‘ The WinCC Web Publishing Wizard is finished colecting information

To publish your pictures. press Firish

ol
SIEMENS

[ Type. =

@) Pefomanceent
@) TANKLEMF
) TANK2 EMF
‘ ) TANK3.EMF
@) VARIANT.EMF
) watungem
W) Weblnterface.PNG
&) WebtefaceDeactivated.PNG

Image
Image
Image
Image
Image
Image
Image
Image

Concel | [ <Back |[ New> | [ Close |

The published pictures are displayed in the
data window of the Web Navigator.

(K5_HP_MP\KS_HP_Priwincpeo]\05_Stiy|05_Sthry.mep =101x]

B 05_Sthy [ Trpe [ Last Change =]

e @u0Lr_ yismisesriem |
P &0ContgTpicas 0 Y1571 4578

TagMarageent
o ' p gsimacere 20 11502015 45716
R Lo——— Y1571 57T
A Aarm Logging P csiomemergency.pé 115018 457170
. 133130005 B eniarmeme gencyOp.pd_ 1572015 4:57:18 PM
&) Report Desgrer P ssiomine.rr_ 115015 45 18P
15 Gobal Srt P exismizonens F0_ 1SS K579
P stomescen 70 15015 45197
(=T P examrsiencp PO 11515 457207
£, Text Disrbuter B oo 75 115015 45720
il user adrsatee D SIS 5721
iy Cross Aevenc P Chiamounal D, YISIS 45721
{3 Redndency pe——— r————
T 1 e P cotamtien0_ 15 4E7IM
@mamriencp 0. 15 wszzIem
9 Toendmmimdery b CaiomOcrD_ s as7zIm
A Hom § ermction e 11572015 w5224
0 Pickre Tree Mansger B @siamOneLine FO. IS8 524N
-1, uebest Mocrrg P siomOperason . 11572018 457280
&, 08 Project Edor P Shiomrocss.0_ pra——
@it PO_ 115018 457257
Companent st Ettor

i P escesputions 70_ IS S57EM
d e p Gscoesverven o, ISOIS A57BPN

- hsses0ve v Toote 50 thsians a5z _Iﬂ

| L
05, Sty e oveator 8 obeci) lceruedmode
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7.4 Configuring the OS Web Server

7.4.2 Setting up user rights, website start screen, and the language

Restriction of access

You can control the access of the Web client to the OS Web Server by defining
user rights. You assign user rights in the “User Administrator” editor. User rights
are the same as those of the standard clients.

Settings in the "User Administrator" editor

Step Action

1. In the WinCC Explorer of the currently
open OS project, open the "User
Administrator” editor.

Create new users and/or new user groups
that you want to assign appropriate
permissions to.

Also select the "Web Navigator" checkbox
for the user(s) or user group(s) and enter
the "Start picture" and “Language” of the
website in the corresponding input fields.

Ble g6t Yiew Help
User Administrat...

X

- Authoriz... £+ | Properties - User

4| 5 selection
Obgect typa
Obgect name
General

Logon wth smart card
Vakie of the tag logon

 Logout
Type of automatc bgoft one
Pariod of time bafore automatc logofl

Erwatterte Bodienung 1 v B

13 [Ervetterte Bedienung 2 v Vieblizagator

VéeDMagator start picture -
wiebUX
Start Picture of WeblX

Englsh (Unted States

German (Germary) | Selection: 1 Authorzations  Tabie: 13 Authorasbons  100% (—

2. Use the "..." button to select the start
picture from the published graphics.
"..\OS Web Server\<wincc-projectshare-
name>\Web Navigator\pictures"

Choose the "@screen.pd_" graphic as the
start picture.

Click on the “Open" button to confirm your
selection

You can also specify a language for the
control and monitoring interface of the
Web clients. To do this, you must also
click on the corresponding "...” button.
Click on the "OK" button to confirm your
selection.

e Edt Yo Hep
User Administrat... «

il ser aaminissrasce

Resay |t

12 [Ewotterto Bedsenung 1
13 [Eveitens Bednung 2

|_user dminstrator - wencC Configuration Sta alnix

[Function Enabie ~| B selection
1 Benutzenverwaltun

]
ch (Object name WebOperator
General

User name WebOperator
Group name. AdmistratorGroup

o automanc lgoft one
[Pariod of tme befora automatic byalf
‘web

WabHavgator

(Wabtiavgatorseart picture | — -
Wabik | GFL_AssETFom 5 0
50

Setesion

3. Close the User Administrator Editor.
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7.4 Configuring the OS Web Server

7.4.3 Configuring using the Web Configurator

Web Configurator tasks

The Web Configurator enables you to configure and manage the Internet
Information Service (IIS) and therefore the website of the OS Web Server. You
make the setting on the Web Server after you have downloaded the project to the
Web Server. Setup and configuration are necessary to set up an operating station
(OS) as an OS Web Server and to make it accessible for the Web clients via the
Intranet/Internet.

The Web Configurator allows you to make the necessary firewall settings, if a
firewall is activated.

Requirements of the Single Station
e The PCS 7 Web Server software has been installed on the Single Station
e The OS project has been downloaded to the Single Station
e All settings have been made in the OS
e Pictures, functions, and graphics have been published
e User rights have been assigned

For more information about setting up the standard Web site, refer to the manual
entitled "SIMATIC PCS 7 Web Option for OS (V9.0)"
https://support.industry.siemens.com/cs/ww/en/view/109746536

Chapter 9: "Completing the configuration on the Web server"

Note
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7.4 Configuring the OS Web Server

Settings in the "Web Navigator" editor

Step Action Note
1. Open the OS project in WinCC Explorer on | EXEIEZETmTs =
the OS Web Server. Welcome to the Intemet Information Server Corfiguration

Use the shortcut menu of the "Web

Navigator" editor to select the "Web
Configurator" command.

The system opens the "WinCC Web
Configurator" dialog box.

Click on "Continue".

The ‘Wb Configurator allows you to create & new Web Navigator
site of change the seftings of an existing one.

Cancel | CEEER Frign

2. In the next window, select "Create a new 2 WinCC Web Configurator ]
standard Web site (Stand-a|0ne)" . Here, you can creste 2 hew standsrd Wb site or 20 a vitual folder to an

_ . existing activated Weh site:
Click on "Continue".

* Cieate a new standard Web site [stand-alone]

€ Addto an existing Web site [virtual folder)

Cancel | <Back  [HEws Frish ]

=

3. Enter a name for your web site in the £ WinCE ieh Confgurator E
"Name of the Web site" text box. (4, o e e e, [P s e TGP sl i

80] far your Weh site:
Also assign the IP address and connection

Marme of the Web site:

port of the computer in the "Port" and "IP [bHavigstor
address" text boxes. Pot 1P Ackhss
fz0 33 |

Under "Default Web-Page”, select
"MainControl" from the drop-down list.
Enter a time interval in the "Reconnect
Interval” text box.

Select the "Start the web-site after being
configured” checkbox.

Diefaul web Fage
MairCantral asp -

Reconnect Interval
10 §

[¥ Start the web-site after being canfigured

Cancel | <Back Next > Firish
Click on "Continue".
If you have not activated the Windows
firewall, continue with step "7".
4. Click on the "Windows Firewall" button (the | EXEEIETTIS S
button is only visible if the firewall is Donfiguing the Windons Fiewal

activated).

Pleass select in the register ‘Sdvanced of “windows Firswal the
network cannection for which users from the Intemet should be
pemitted access. Activate the servicss "Webserver [HT TP ar ‘Securs
\webServer [HTTPS)'

Windows-Firewall

Cancel < Back e

PCS 7 Minimal Configurations
Entry ID: 24023824, V7.1, 02/2018 121



© Siemens AG 2018 All rights reserved

7 Expansion with the PCS 7 OS Web Option

7.4 Configuring the OS Web Server

Step Action

Note

"Windows Firewall" dialog box.

5. Click the "Advanced Settings" button in the

=)

(I WP~ ConolPan = A Conr P i = W Fremsl o @ [roree B
| Fe Edt ves Tods Hep
Canirol Parel Home Help w b
ket your computer it Wankows Fnal
Ao & program or festure vindows Fmewial can ek prevent Rackers of makoeus software from garing acoess I your CompUter trough e
thecugh tincous Frewal Interat or & natwork.
9 o ottt tie [P ———
% Tum Windoms Frewall on ar off Vst are nefierk oessons
& et s | ER— pe—~|
& Advarced setings. Metworks at hame or work hert vou krow 8nd Tust the peopss and devioes on the network
R —,
[FES— on
omng eacions. S ———
st
[ET——— B et
[rr— Sty e e o et bk e rcran
| Comected 2]
Metworks in puble places such a3 arports or coffee: shops
RE—— o
—— okl eeecaons g ot re e
i wagans
[r— o
Secaiso
il tcaton s Vst e hn s Frewatbod 3w prgran

Nntwerk and Sharing Centar

6. Check whether the "World Wide Web

highlight it and choose the "Enable"
command in the shortcut menu.

Services (HTTP Traffic-In) inbound rule is
activated. If this function is deactivated,

i

Mede Player Netwerk Sharing
Media Player Network Sharng No Mow Mo
indows Meda Player Netwark Sharng Ser Mo How Mo
No Mow Mo
Searity Associatons o How Mo
o How Mo
No Mow Mo
No Mow Mo
o How Mo
Peer to Peer Colaboration Foundston (S50-Ir) o How Mo
s Peer to Peer Collsberstion Foundatin (TCP-In) No Mow Mo
doms Peer 1o Peer Colaboration Foundaten (WSD-in) No Now Mo
@ vrdows Remote Management - Compatbilty Mode (HTTP-In) o How Mo
Compat 47TP-1n) o How Mo
4TTPAn) No How Mo
@ Wrdons Remote Mensgement (HTTP-in) No Mow Mo
@ \eeless Portable Devices (SS0P-in) o Mow Mo
@ ireless Portable Devices (UPrP-in) No Aow Mo
Traffcin) Yes Mow Mo =
< | 2ld | >

7. Click on the "Finish” button.

C5 winCC Web Configurator |

Configuring the Windows-Firewal

Plaass select in the register ‘Sdvanced of “windows Firewal the
network cannection for which users from the Intemet should be
pemitted access. Activate the servicss "Webserver (HT TP} ar ‘Securs
\webServer (HTTPS)'

‘Windows-Firewall

Cancel | <Back | Heds | T

8. Click on the "OK" button.

your computer to apply the settings.

Then, close WinCC Explorer and restart

WinCC Web Configurator =

. The Inetinfo parameters were set, It's recommended to restart
_l_s your system.
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7.4 Configuring the OS Web Server

7.4.4 Downloading and compiling the Web Server

Downloading the Web Server

Since the OS Web Server function is on a Single Station (ES/OS/Web Server), it is
not necessary to carry out downloading or change downloading of project data.
Due to the "Compile OS", the necessary data is already present locally.

Compile
The "Compile Changes" function can be executed in Single Station without having
to interrupt the process mode of the Web Server.
Note For more information about “Configuring the OS Web Server”, refer to the

manual entitled "SIMATIC PCS 7 Web Option for OS (V9.0)"
https://support.industry.siemens.com/cs/ww/en/view/109746536
(Chapter 8: "Configuring the Web server on an ES")
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7.5 Settings on the Web client

7.5

Settings on the Web client

Settings for the "Internet" or "Local Intranet” Web content zone

In Internet Explorer, you must make/check the settings for the Web content zone
such that you will be able to install the plug-ins for the Web client from the OS Web

server later.

Step

Action

Note

Open Internet Explorer.

Select the
“Tools > Internet Options” menu command.

* Internet Explorer cannot display the webpage - Windows =100 =]

¢ Favorites J 9% @] S5uggestedSites = | Web Sice Gallery -

(& Internet Explorer cannot ... | H %5 v~ B v [ m0 - Page~ Safety v | Took -

go.microsoft... (x| | #2|| X | [P 6ing ol-

[e] hes

'EX Diagnose Connection Problems. ..

3 {5 Reopen Last Browsing Session
Internet Explorer ca
() Pop-up Blocker »

[ Manage Add-ons

What you can try: &% Work Offline
= Compatibility View
Diagnose Connection P Compatibility View Settings
Full Screen F11
@ More infarmation Toolbars
Explorer Bars 4

<l Developer Tools Fi2

Suggested Sites

| =

[Fa-[Rwow ~ 4

[ [ [ [ [ @ mntemet| Protected Mode: OFf

Click on the "Security" tab.

Highlight the Web content zone in which
the Web server is located
("Internet" or "Local intranet").

Click on the "Custom Level" button.

General Security |Pri\c'aq-I | Content | Connections | Programs | Advanced |

Select a zone to view or change security settings.

@ & / O

Internet  [RIEGNENREE Trusted sites  Restricted
sites

Sites

Local intranet

& This zone is for all websites that are
= found on your intranet.

~Security level for this zone
Allowed levels for this zone: Al
- [ - Medium-low
- Appropriate for websites on your local network
- (intranet)
N . - Most content will be run without prompting you
_-I_I_ - Unsigned ActiveX controls will not be downloaded
- Same as Medium level without prompts

[~ Enable Protected Mode (requires restarting Internet Explorer)

Custom level... Default exvel |

Reset all zones to default level |

OK I Cancel | Apnly |
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7.5 Settings on the Web client
Step Action Note
3. Select the radio buttons under "Run x|
ActiveX controls that are safe for scripting” " CGettings
and "Download signed ActiveX controls". 7 Actvat controls and plag e =
o |@| Allow previously unused ActiveX controls to run without prom
) Disable
(&) Enable J
|#| Allow Scriptlets
) Disable
{2} Enable
) Prompt
|#| Automatic prompting for ActiveX controls
) Disable
(&) Enable
|| Binary and script behaviors
O Administrator approved
) Disable
(®) Enable
J ) Nienlaw viden and animatinn an a wﬂTann that dnee nnt ET_I
*Takes effect after you restart Internet Explorer
Reset custom settings
Resetto:  |medium-ow (default) j Reset... |
OK I Cancel |
4. Click on each of the "OK" buttons for the
"Security Settings" and "Internet Options"
dialog boxes to close them.
PCS 7 Minimal Configurations
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7.5 Settings on the Web client

Settings for the "Trusted sites" Web content zone

Step Action Note
1. Open Internet Explorer. 7 Internct Explover cannet tapi e RO o
Select the e le wosof... ]| é2 || x| [ 50 Al
“TOOlS > Internet OptiOﬂS" menu Command. J 7 Favorites J 9% £] Suggested Sites @] Web Slice Gallery +
(& Internet Explorer cannot ... | H %5 v~ B v [ m0 - Page~ Safety v | Took -
'EX Diagnose Connection Problems. ..
Q Internet Exp\orer . | Reopen Last Browsing Session
] Pop-up Blocker »

[ Manage Add-ons

What you can try: €3¢ Work Offline
5 Compatibility View

Diagnose Connection P Compatibiity View Settings

Full Screen F11
@ More infarmation Toolbars 4
Explorer Bars »
<l Developer Tools F12
Suggested Sites

< | 2l
[ [ [ [ | [ miemet|Protected Mode: OFF [% - [Rwo% -
2. | Click on the "Security" tab. 21
nghllght the "Trusted sites” Web content General Security |Privacy' I Conbentl Connections I Programs I Advanced |
zone.
Click on the "Sites" button to open the Select a zone to view or change security settings.

dialog box. @ G}e \/ ®

Internet  Local intranet OEEEElY — Restricted
sites

Trusted sites =
ites |
j This zone contains websites that you

trust not to damage your computer or
your files.

~Security level for this zone

Custom
Custom settings.
-To change the settings, dick Custom level,
-To use the recommended settings, dick Default level.

[~ Enable Protected Mode (requires restarting Internet Explorer)

Custom level... Default level |

Reset all zones to default level |

OK I Cancel | Aol |

3. In the text box "Add this website to the x|
zone", enter the address of the OS Web
server (7.4.3 Configuring with the Web
Configurator > Settings in the "Web
Navigator" editor), ; ;

Add this website to the zone:

e.g. *://172.61.0.1 or [Pt //172.610.1

47 You can add and remove websites from this zone, All websites in
Tl this zone will use the zone's security settings.

http://*.microsoft.com

Also, clear the "Require server verification
(https:) for all sites in this zone” checkbox.

Click on the "Add" and "Close" buttons.

Websites:
http:f/172.61.0.1 Remave

™ Require server verification (hitps:) for all sites in this zone

Close |
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Step Action Note

4, Highlight the “Trusted sites” Web content 2l x|
zone. General Security |Pri\c’aq-I I Conbentl Connections | Programs I Advanced |
Click on the "Default level" button and then
on the "Custom level" button. Select a zone to view or change security settings.

@ & v O

Internet  Localintranet Trustedsites  Restricted
sites

Trusted sites =
ites
f This zone contains websites that you

trust not to damage your computer or
your files.
You have websites in this zone.

[~ Security level for this zone
Allowed levels for this zone: Al

- - Medium
- I - Prompts before downloading potentially unsafe

4 - content
_'I_I_ - Unsigned ActiveX controls will not be downloaded

[™ Enable Protected Mode {requires restarting Internet Explorer)
Custom level... I Default leyvel |

Reset all zones to default level |

0K | Cancel | Apply |

5. In the "Security Settings" dialog box, select x|
the radio button under "Initialize and script ~Settings
AC“VeX ContrOIS not marked as Safe for |#| Initialize and script ActiveX controls not marked as safe for sc;l
scripting”. O Disable
&

) Prompt
|#| Only allow approved domains to use ActiveX without prompt

(%) Disable

) Enable
|#| Run ActiveX controls and plug-ins

) Administrator approved

O Disable

() Enzble

) Prompt
|| Soipt ActiveX controls marked safe for scripting™

{ Disable

(%) Enable

™ Promnt hd
< | »

*Takes effect after you restart Internet Explorer

Reset custom settings

Reset to: IMedium (default) j Reset... |
OK I Cancel |

6. Click on each of the "OK" buttons for the
"Security Settings" and "Internet Options"
dialog boxes to close them.

You have now created the conditions that are needed to connect from a Web client
to a Web server.
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7.6 Installing the Web client plug-ins

7.6 Installing the Web client plug-ins

Installation methods

During installation of plug-ins for Internet Explorer, you can choose between two
installation methods:

e Remote Installation - Installation via the Intranet/Internet from the Web server
e Local Installation - Installation via the Windows installer package of the Web client
In this application example, we will consider "remote installation”.

Requirements
e The OS Web server is in runtime.
e The"PCS 7 Web Client" software package has been installed on the PC.
e The Web client has access to the Web server.
¢ You know the Web server's address.
¢ You know the domain name, user name, and password.
e The user permissions apply to the PCS 7 Web Options.
e The logon on the PC has the rights of a primary user.

Installation
Step Action Note
1. Open Internet Explorer. 3 o

Enter the web server address
(http://<server name or IP>) in the
"Address" text box.

- 0K

T © e v o

2. In the "Enter Network Password" dialog Windows Security =
bOX1 enter the Credentials that were set in The server 192,168.8.152 at 192.168.8. 152 requires a username and password,
the nuser AdmInIStrator“ edltor on the Web Warning: This server is requesting that your username and password be sent in
server. an insecure manner (basic authentication without a secure connection).

' —
|
E ] Fe:" rd

Bl Remember my credentials

OK I Cancel
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7.6 Installing the Web client plug-ins

Warning" dialog box opens.
Proceed by clicking on the "Install" button.

Step Action Note
3. When you first connect, the "Security =

Do you want to run this ActiveX control?

Mame: WebClientinstall Module
Fublisher: Siemens AG

BLII'II ’WI

l-" This ActiveX control was previously added to your computer when you installed
\l'?) another program, or when Windows was installed. You should only run it if you
= trust the publisher and the website requesting it. What's the risk?

4. The system now displays all of the
available plug-ins for the Web client in the
Internet Explorer window.

To install the plug-in, click on the arrow in
front of the version number in the "Install”
column.

The following plug-ins are installed to
ensure a minimum of process control:

e  WIinCC Basic Process Control

e WIinCC Advanced Process Control
e PCS 7 Basic Faceplates

e PCS 7 Advanced Faceplates

During installation, always proceed in the
order that is shown.

alnix

e |1 T T Ty

Download/Install - WinCC/WebNavigator Custom Plugins

5. Installation of the Web client is complete.
Close Internet Explorer and reopen it to
register for process control.

The process pictures can be called once
the Web client has established a
connection to the Web server.

Hst] § QY v B BB T RANH

Note For more information about "Installing a Web client", "Process control on the
Web client" and "Settings", refer to the manual entitled "SIMATIC PCS 7 Web

Option for OS (V9.0)"

https://support.industry.siemens.com/cs/ww/en/view/109746536

(Chapter 10: "Installation and settings for the Web client")
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8 History

Version Date Change

V1.0 10/2006 First edition V6.1 SP1

V1.1 11/2006 Revised V6.1 SP1

V1.2 05/2009 Revised V6.1 SP1

V2.1 09/2008 First edition V7.0 SP1

V2.2 12/2008 Correction of table 6-2

V2.3 05/2009 Revision V7.0 SP1

V3.0 05/2009 First edition V7.1

V3.1 05/2009 Revision V7.1

V3.2 11/2009 Extension of the document for V7.1 to include the PCS 7
Web Option (tested for PCS 7 V7.1 and V7.0 SP2)

V2.4 12/2010 Note added:
The configuration described in chapter 6, "Master ES/OS
and Standby OS" only works in PCS 7 V7.0 SP3 if it has
WinCC V6.2 SP3 HF8 or higher.

V3.3 09/2011 Note added:
The configuration described in chapter 6, "Master ES/OS
and Standby OS" only works in PCS 7 V7.1 SP2 and SP3 if
it has WinCC V7.0 SP2 HF5 or higher.

V4.0 10/2012 First edition PCS 7 V8.0 Upd1l

V4.1 11/2012 Adaptations in the following chapters:
e  Chapter 7 "Expansion with the PCS 7 OS Web Option"
e Chapter 7.1 "Web configurations"
e Chapter 7.2 "Web-specific hardware and software

requirements"
New chapter:
e  Chapter 7.3 "Maximum number of Web client
connections"

V4.2 01/2013 Introduction in chapter 6 "Master ES/OS and Standby OS"
has been editorially revised.

V4.3 05/2013 Test and declaration for PCS 7 V8.0 SP1

V4.4 09/2013 License adjustments in chapter 7.1. "Web configurations" in
Fig. 7-1 "Web Option in Single Station"

V5.0 02/2015 Test and declaration for PCS 7 V8.1

V6.0 06/2016 Test and declaration for PCS 7 V8.2

V7.0 11/2017 Expansion of time synchronization in chapter 3 "ES/OS
Single Station”
Test and declaration for PCS 7 V9.0

V7.1 02/2018 Step added (Configuring the standard server) in chapter
5.3.3 "OS configuration” OS Client
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